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TintWise POS

Introduction

The software described in the present manual has been entirely developed by the software office
of Hero Europe S.r.l, with the purpose of addressing all possible situations that may arise,
according to the experience and suggestions of our technical assistance service.

Therefore new functionalities have been added while trying to keep the application as simple to
use as possible.

Nonetheless, reading the present user’s manual before starting to use the software is highly
recommended.

The TintWise POS (Point of Sales) software allows managing most HERO dispensers. The software
features two main areas:

1. Managing the formula

a. Described in detail further in this chapter.

2. Managing the dispenser

a. Described in the next chapter; it differs from dispenser to dispenser.

The TintWise interface is simple and intuitive, very easy to use even for inexperienced users.
TintWise can manage various log-in levels, so some features later described may be accessed only
with the proper log-in level.



Minimum system requirements

Full compatibility is guaranteed with Microsoft window XP and Vista.
Requirements:

. Screen resolution: 1024x768 or higher.

. 1.4 GHz Celeron processor (2.0 GHz Pentium 4 or higher - recommended).

. 256 MB RAM or higher (512 MB recommended).

. Operating system: window XP Home, window XP Pro or window Vista.*

. For other peripherals (USB, serial ports, etc.) see the chapter about the dispenser model

you are using (recommended: 4 USB ports + 1 serial port + 2 PS2 ports for mouse and keyboard).

NOTICE: every peripheral or external drive (printers, labelling machines, spectrophotometers, etc.)
may need further specific ports.

* Note:

. The software can run under window 2000, but Microsoft .NET Framework 2.0 must be
installed (Internet Explorer 5.0.1 or higher, window Installer 2.0 or higher) before running the
TintWise setup.

. A light version of TintWise is available which can run under window 98, but Microsoft .NET
Framework 2.0 (Internet Explorer 5.0.1 or higher, window Installer 2.0 or higher) and Microsoft
Data Access Components (MDAC) must be installed before running the TintWise setup. Running
the software under window 98 is not recommended because of functionalities limitations.



Software installations

To install the software run the Setup.exe file from the installation CD and follow the screen
instructions.

Select Setup Language E'

Select the language to uze during the installation:

| E nglizh

|

OF. ][ Cancel ]

Picture 1: Select your language and click OK.

® Setup - HERO TintWise

Welcome to the HERO TintWise
Setup Wizard

Thiz will ingtall HERO Tintwize_POS 5.1.0.16 on wour
computer.

[t iz recommended that you cloze all other applications before
continuing.

Click Mest to continue, or Cancel to exit Setup.

Memt » ][ Cancel

Picture 2: Click Next.



{® Setup - HERO TintWise

Select Destination Location
YWhere should HERO Tintwise be installed?

_;J Setup will install HERD Tintwize into the following folder.

To continue, click Mest. If pou would ke to zelect a different folder, click Browse.

|:::'-.HEF: 0 5hw

| [ Browse. .

A leazt 34,0 ME of free dizk zpace iz required.

¢ Back ” P et > l[ Cancel ]

Picture 3: Click Next. We recommend to do not change the installation path.

{® Setup - HERO TintWise

Select Data Folder
YWhere should data files be installed?

Select the folder in which Setup should install perzonal data files, then click Mext.

CAHERD SwihDiata | [ Browse. .. ]

¢ Back ” et > l[ Cancel

Picture 4: Click Next. We recommend to do not change the installation path.



{® Setup - HERO TintWise

Select Start Menu Folder
Where should Setup place the program's shortcuts?

Setup will create the program's shaortouts in the following Start benu folder.

To continue, click Mest. If pou would ke to zelect a different folder, click Browse.

| [ Browse. .

[ ] Don't create a Start Menu folder

¢ Back ” P et > l[ Cancel ]

Picture 5: The name of the Start Menu folder can be changed. Click Next.

{® Setup - HERO TintWise

Select Additional Tasks
YWhich additional tazks should be performed?

Select the additional tazks vou would like Setup to perform while instaling HERO
Tintwfize, then click Mesxt

Drriver

() Archimede
) Eureka

() Mewton, Teo
) -none-
Addition

[ cTx 1

Additional icons;

[(*

[+] Create a desktop icon Bt

¢ Back ” et > l[ Cancel

Picture 6: Select your dispenser type and click Next. If a CTX automatic agitator is present, select the corresponding
voice.



{® Setup - HERO TintWise

Ready to Install
Setup iz now ready to begin instaling HERD Tinfwize on your computer,

Click Inztall to continue with the installation, or click Back if you want to review or
change any settings.

Destination lacation;
C:AHERO_S'bin
C:AHERD_S'w™Drata [Data Folder]

< Back ” [rztall l[ Cancel

Picture 7: Click Install.

® Setup - HERO TintWise

Completing the HERO TintWise
Setup Wizard

Setup haz finished instaling HERO Tinfwize on vaur computer.
_The application may be launched by selecting the installed
atuly S

Click Finizh o exit Setup.

[] Launch Tintwize

Picture 8: Click Finish.

Depending on your dispenser model, the installation CD will provide all necessary drivers.



Main window

The TintWise start window shows the main operating instructions and operations.

Selecting and dispensing formulas is possible directly from the main window. Buttons and menus
give access to all of the other functionalities.

The main window can be customized and differ from user to user (Title, Logo, etc.) according to
the installed database and the current login level (see Managing Logins).

© TintWise

File Dispenser utilities Tools 7

‘Standard [Custom |[Search |
— Collection 3 %E%@

Product 1

405

Base B1: 1Lt

®

15 Lt 25 Lt Custom
| 1Cans §| .
C4 - Colorant 4 : 1,719 ml g
C12 - Colorant 12 : 26,047 ml DELETE FORMULA
- C13 - Colorant 13 : 8,480 ml = -
_»a C1 - Colorant 1 : 46,104 ml £
CUSTOMER i Bt
-MNot set- 2 -t
) £,
LOGIN PRINT LABEL

CANISTERS - EDIT FORMULA

9 & B

EXIT DISPENSE & MANUAL FORMULA

Demo Operator Databaze: STD 1.0.0 07/09/2009 16.04
Picture 9: Main window

Left side buttons — basic operations:

. Customer: opens the customer selection window

. Login: opens the login window

. Canister: opens the window for the dispenser canisters, to manage possible filling-ups or
purges.

. Exit: exits the application

Right side buttons — formula management:

. Delete Formula: delete the selected formula (only for custom formulas)

. Print Label: prints one or more labels for the selected formula.

. Edit Formula: changes the selected formula and possibly save it as a custom formula.
. Manual Formula: creates, dispense and saves a new formula.
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Formulation can be accessed from the following sections in the central area:

. Standard: standard formulation cannot be changed with TintWise POS. Database Upgrades
can be made with the TintWise LAB software.

. Custom: custom formula, as edited in the New/Edit windows.

. Search: advanced search for a standard formula through the color code.

. Production queue: if a production queue has been created, a section is added to manage it.

To view the info on the desired section, click the corresponding voice.

12



Selection and dispense of a standard formula
Depending on how it is created, formulation can be divided on various selection levels. TintWise
will show a grid for each level. In the Picture below (Picture 10), formulation is viewed by

Collection and Product.
By clicking on the corresponding voice, the selection field is expanded.

Collection 1
[Callection
#

p [Collection 1

Collection 2

Collection 3
Picture 10: Collection selection.

Collection 2

Product 1

[T e ]
Product 2 Pdact; 44

Product 1

Product 3

Picture 11: Product selection.
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401
401 4

Code > -]
} R

402
403
404
405
406
407
408
409
410
111
412
413
414
415
416
117
418
419
420
421
422
423
424 |

] 4]1 7445 b ]

Picture 12: Formula selection.

Selecting is possible either by double clicking the chosen line or by writing the instruction in the
text field on top of the grid and pressing ENTER to confirm. Auto-completion will suggest various
options as you write.

Clicking the Zoom icon opens a new text field, in which filter instructions are displayed as entered.
In Picture 13 the filter is set on “70”, so only the voices containing “70” are displayed in the grid.

14



Collection 1
Product 1

405

700 Fill

Code >

670

p (700

0

702

03

704

05

706

f07

708

09

Picture 13: Example of filter

Once the formula is selected, it is possible to select the desired fill level.

Depending on the installed database, different fill level can be obtained according to the product

and the base selected for a specific formula.
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© TintWise

File Dispenser utilities Tools 7

Standard |

|

| |

Collection 2
Product 2
405

Base B1: 5 Lt

e

FoERD

INNOVATIVE 0007 TECHNOLOEY

2

DELETE FORMULA
25 Lt Custom > 2
[ 1 Cans '*@
C3 - Colorant 3 : 67.587 ml ADD TO QUEUE
a C7 - Colorant 7 : 124.785 ml —
& C8 - Colorant 8 - 14.169 ml
LOGIN C1 - Colorant 1 : 184.453 ml VIEW PRICE
A, =N
LOGOUT PRINT LABEL
m E
CANISTERS - _ EDIT FORMULA
9 &) P
EXIT DISPENSE MANUAL FORMULA
Dema Administrator [atabage: STD_21.0.0 04/06/2009 11.23

Picture 14: fill level selection

The formula is automatically re-edited according to the fill level selected. If it is not among the
available ones, a custom fill level can be selected by double clicking the red can icon “Custom”.

Cusktom can |E
3.0000 %Lt
3Lt
15 Lt Type
251Lt {%) Can capacity
{:} Base guantity
{7 Finished product
E lm a_;aj_
OK Cancel

Picture 15: custom fill level

A custom fill level can be set to re-edit the formula depending on:
. Can capacity: the formula is re-edited proportionally to the other available fill level.
. Base quantity: the formula is re-edited on the actual quantity of base present in the fill

level.

. Finished Product: the formula is re-edited on the finished product, that is base + coloring.



After selecting the desired fill level, set the number of cans to dispense, click “dispense” (or press
F2 on the keyboard) and follow the instructions.

If customer management is available, you will be asked to select it (if not already selected).

Customer Selection £

Customer 3

Customer 1

Customer 2
Cuztomer 3
-.[ilstumer 4..

Customer 5

Keep it for next dispenszes

4 9
OK { E it

Picture 16: Customer selection

Select the chosen customer from the list or write it in the upper box to add a new one and click
Ok.

The “Keep it for next dispenses” option will allow you to keep the chosen customer valid for next
dispensing too.
It’s possible to reach the same window clicking the related button from the main page.

When necessary you will be asked to insert a can.
Dispense

Collection 2 1 B
Product 2
405
B1: 1Lt

Insert can

@H@

QK Undo

Picture 17: Insert can

By clicking “OK” the dispensing starts. Picture 18 shows how it is displayed while running.

17



. C1 - Colorant 1
. C8 - Colorant 8
C7 - Colorant 7

Bc:

Base B1

1 Lt

Picture 18: Running dispensing

By clicking “Stop”, the dispensing is immediately interrupted. During the color mixing an animation
is displayed. At the end a confirmation message will pop up.

Information [§|

\:Er) End of dispense

Picture 19: Finished dispensing

If the required quantity of color is not available, or in case of alert, the window shown in Picture
20 will pop up before Dispense starts. For possible filling-up of purges, click “View” to access the
Can window, and then proceed with dispensing.

18



Formula not available

g Some components are not available

ALERT LEVEL
C3 Colorant 3

& 9

View Abort dispense

Picture 20: Filling-up required
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Selecting and dispensing a custom formula

Custom formulas are stored with many keys, so that inserting more information and selecting
operations can be easier.

The number and description of those keys can be edited in the Software Option window, later
discussed.

I Custcrm“E.__m___.__. |

Collection 1
Product 1
101

Picture 21: Selecting a custom formula

Once the formula is selected, follow the instructions given for standard formulas.

20



Advanced search

The Advanced Search tool allows selecting a formula by its color code, thus ignoring any previous
selection.

To use the tool a search function must be created, either through the TintWise LAB software (see
the user’s manual), or directly from TintWise POS. An appropriate login level is necessary to create
an advanced search.

After the advanced search is created, the “Search” button will appear in the main window.

At this point the color code must be selected first, and then TintWise will display all products
containing the selected code.

401
401 A4

Code > -]
’ e

402
403
4104
405
4106
407
4108
409
110
411
112
413
1114
415
116
117
116
4119
420
421
422
423
424 _ZJ

4] 4|1/ 445 b [M]

Picture 22: Color code selection
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401

[Collection'Product]

Collection 1
Collection > FProduct
4
Collection 1 Product 2
Collection 2 Product 1
Collection 2 Product 2
Collection 3 Product 1
Collection 3 Product 2

Picture 23: Product selection

After selecting the product, follow the instructions for standard formulas.
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Creating / Editing a formula

It is possible to edit and/or save a custom formula from an existing one (“Edit” button in the main
window) or create a new one (“New” button in the main window).

In both cases the same window will be accessed; if editing occurs, the selected formula data will
be shown.

The window can be used both to manually edit and save a custom formula.

Collection 2
Product 2
B1
5Lt
d
h Lt 25 Lt Custom
Code
405
. C1 - Colorant 1 184.453 ml . C9 - Colorant 9
— /|l c2- colorant 2 il c1o- cotorant 10
. C3 - Colorant 3 67.587 ml C11 - Colorant 11
¢+ - colorant 4 lci2-cotorant 12
C5 - Colorant 5 13- colorant 13
[ c: - colorant 5 ll c14- colorant 14
il c7 - colorant 7 124.785 ml il c15 - colorant 15
e coorants 14.169 ml 16 - cotorant 16
DISPENSE
= e Fwi
i i
& (o 9
Prirt labal : price Cave =
Recalculate quantity Print label 1 F I ave Exit

Picture 24: New/Edit formula

As with the standard formula it is possible to set the various selection levels, the fill level and the
base quantity set for the formula.

By disabling the “Recalculate quantity” (lower left corner), it is possible to change the fill level
while keeping the formula unchanged.

To edit a formula just enter the dosage quantity in the proper colorants text fields and click
“Dispense”.

By clicking the “Save” button, a confirmation on the search keys will be required to save the
custom formula.

23



Keyl

Formula Code

Key?2

Formula Description|

Key3

a 9

OK Cancel

Picture 25: Custom formula keys

Click “OK” to save the formula.

24



Canisters window

The Canisters window can be accessed directly from the main window by clicking the
corresponding button. It also pops up automatically whenever a filling-up is needed before a
dispense, as previously discussed.

Depending on the login level, the window will show more or less options.

At Operator level, only filling-ups and purges can be made, besides monitoring the present levels.
Most Hero dispensers can’t determine the levels automatically, so the values must be updated
manually if a filling-up is needed; if a scale is connected to the dispenser, an automatic setting will
manage the operations above on the basis of a theoretical or real value.

NOTICE: the product dispensed with manual commands will not be taken off automatically.

5.000 Lt
3.000 Lt
3.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt
3.000 Lt
2.000 Lt
3.000 Lt
2.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt

1 C1 Colorant 1

2 (C2 Colorant 2

3 C3 Colorant 3

4 C4 Colorant 4

5 C5 Coloranth

6 C6 Colorant 6

? C7 Colorant 7

8 C8 Colorant 8

9 C3 Colorant 9

10 C10 Colorant 10

11 €11 Colorant 11

12 C12 Colorant 12

13 €13 Colorant 13

14 C14 Colorant 14

15 C15 Colorant 15

16 C16 Colorant 16

B & D

Purge all Purge canisters in alert Start agitation Exit
Picture 26: Canisters window
The window lists:
1. The canister number
2. The code and description of the associated color
3. A graphical view of the present canister level. The vertical red and yellow lines represent
the alert and warning level.
4, The quantity of color in the canister (in the chosen unit)

5. The filling-up button.
6. The purge button.

25



If the filling-up button is red, then the corresponding canister is below alert level (Picture 26,
canister 3), when it is yellow, then it is below warning level (Picture 26, canister 4).

When the purge button is red, then the corresponding canister is on red alert, because it was not
used recently and a purge is needed before using it.

Alert and purge modes depend on the parameters described later in this chapter.

Buttons:

. Purge all: all canisters are purged (except the empty ones).

. Purge canisters in alert: all canisters in alert are purged.

. Start agitation: allows agitating the color in the canisters, very useful especially after filling-

up. Agitation will stop automatically after a few minutes, but it can be stopped manually at any
time by pressing the proper button.
. Exit: exits the canisters window

Click the filling-up button, enter the fill-up quantity and press “Add”.

Add to canister 1 - C1 Colorant 1

EIL] ot

1,000 Lt

& 9

".'r""-\:i 5:! { i...t} @ I_.jrl 'L-] O

Picture 27: Filling-up

TintWise prevents the user from typing in an incorrect quantity beyond canister’s capacity. In that
case the text field will turn yellow.

Add to canister 1 - C1 Colorant 1

EIL] gt

50,000 Lt

Ul 9

i‘-'-:i 5;; J. i...t} \ﬂ_n) I...;rl 1:] 1:}

Picture 28: Exceeding quantity warning

By the two buttons on the top-left of the window it’s possible to calculate the quantity to
empty/full the canister.
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By clicking the scale icon an automatic filling-up can be done, and TintWise will determine the
filling-up needed by comparing the weight of the canister before and after use.

Add to canister 4 - C4 Colorant 4

%ﬁ Insert the can on the scale

-

@ | 9

Previous | MNext Undo

Picture 29: Automatic filling-up

Add to canister 4 - C4 Colorant 4

L

Fill up the canister
Insert the can on the scale

-

-

= & 9

Previous MNext Undo

Picture 30: Automatic filling-up

If the dispenser is not connected to a scale, the weight can’t be read automatically, so the user
must type it in manually.

Insert data (qg) X

Please enter weight displayed on scale

2100.00000 g

@ 9

QK Cancel

Picture 31: Weight balancing



With a higher login level more options become available.

1 C1 Colorant 1

2 C2 Colorant 2

3 C3 Colorant 3

4 C4 Colorant 4

5 C5 Colorant5

6 Cb Colorant b

? C7 Colorant 7

8 C8 Colorant 8

9 C9 Colorant9

10 C10 Colorant 10

11 C11 Colorant 11

12 C12 Colorant 12

13 C13 Colorant 13

14 C14 Colorant 14

15 C15 Colorant 15

16 C16 Colorant 16

5.000 Lt
3.000 Lt
3.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt
3.000 Lt
2.000 Lt
3.000 Lt
2.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt
5.000 Lt
3.000 Lt
3.000 Lt

2 Uil

Purge all Purge canisters in alert

Start agitation

" TN nn

Fill all canisters at

D

Exit

Picture 32: Canisters window with login

The “Fill all canisters” button allows setting the same quantity for all the levels with a single click.
The arrow button on every line shows more details about the selected canister.
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Canister detail x|

il A?d :I Er?pty P?:ge Advanfd purge Cagale
3.000 Lt 7]
5.000 Lt
3.000 Lt
3.000 Lt
3.000 Lt
2.000 Lt =3
3.000 Lt
2.000 Lt
5.000 Lt
3.000 Lt =3
3.000 Lt
5.000 Lt _.”:J'";J:’L"'
3.000 Lt B _
s Purge settings

Calibration settings

B 1 = &y 9

Purge all Purge canisters in alert Start agitation Fill all canisters at Exit

1 C1 Colorant 1

2 C2 Colorant 2

3 C3 Colorant 3

Current level

- 3.000 Lt

4 C4 Colorant 4

5 5 Colorant5

6 C6 Colorant b

7 C7 Colorant 7

8 C8 Colorant 8

9 (9 Colorant 9

10 C10 Colorant 10

11 C11 Colorant 11

|

12 C12 Colorant12

13 C13 Colorant13

14 C14 Colorant 14

15 C15 Colorant 15

16 C16 Colorant 16

<«

<«

Picture 33: Canister detail

Detail buttons:

. Add: filling-up

. Full: sets the canister level at its capacity.

. Empty: sets the canister level at zero.

. Purge: purges with “normal purge” parameters.

. Advanced purge: purges with “Advanced purge” parameters.

. Calibrate: opens the calibration window (see chapter “dispensers”

The canister/color association can be changed from the drop-down menu above.

Canister detail % |
@ B & @ D
Add Full Empty Purge Advanced purge Calibrate

C1 Colorant 1

C1 Colorant 1
C2 Colorant 2
C4 Colorant 4 z
C5 Colorant 5 E
0
C9 Colorant 9

C11 Colorant 11

C14 Colorant 14 b

Picture 34: Change association

3L |
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Dispense

< ) Change association
-x_f/ Canisker: 1

Colorant: Ca

Si | Mo

Picture 35: Change association

A color can be associated to more canisters. This function is called “multi canister”. Depending on
the dispenser, various optimizations are run on the dispenses in order to increase its performance.

“Multi canister” can both increase the available capacity and reduce dispense times when more
dispensers work together.

Canister data can be accessed and changed in the detail window.
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Canister detail % |

a8 8 & 3 ®

Add Full Empty Purge Advanced purge Calibrate
|E1 Colorant 1 w

Levelz

Capacity
5.000 Lt

Current level
000 Lt

Wwarning level
0.500 Lt

Alert level
0.300 Lt

11

Purge settings

L1

Calibration szettings

Picture 36: Levels detail

Picture 36 shows how to change alert and warning levels, the present level and the canister
capacity. Some changes may not be possible without the appropriate login level.

Notice: the dispensing will be stopped if the color level in the canister is below alert level; the
warning is used to tell the operator that the product is running out, but it doesn’t stop the
dispense.



Purge parameters

Purge parameters can differ from dispenser to dispenser. In the next paragraph the basic features
shared among all Hero dispensers are reviewed.

Canister detail [
a8 B & @ =
Add Full Empty Purge Advanced purge Calibrate
|E1 Colorant 1 v|
Levels >

»

Purge settings

Mormal Advanced Running in
& &
Quantity 0.5 ml 2 ml 1 ml
Speed 25 % 25 % 25 %
Unblock cycles 0 Times 3 Times 1 Times
Unblock quantity 0.1 mi 0.1 mi 0.1 mi
Unblock zpeed (14 (14 (14
Advanced settings | Mo Mo Mo
Alert time 24 h ¥2h 12h

0.47 h zince lazt dispenze

L1

Cahbration zettings

Picture 37: purge parameters

Purge settings can be customized for each canister. That allows managing the purge operations in
most appropriate way for every different color.

Two different purge settings are available for each canister: normal and advanced. TintWise
automatically selects the setting type depending on how long the circuit was unused.

The advanced purge settings apply to canisters unused for a very long time, as define in the voice
“Alert time”.

In the example in Picture 37:

. If the circuit was used over the last 12 hours then it is not in purge alert, so dispensing is
possible.
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. If the circuit was unused over the last 12 hours, then it is in purge alert, and purge before
dispense is necessary.

. If 12 to 72 hours have passed since last use, TintWise uses the normal purge settings.
. If more than 72 hours have passed since last use, TintWise uses the advanced purge
settings.

Some dispensers feature a column called “Run-in”. Data inserted in that column will replace the
normal purge settings during the first stage of the pump’s activity.

All parameters can be edited by double clicking the corresponding voice.

. Quantity: set the purge quantity dispense.

. Speed: set the engine/pump speed for purge.

. Unlock cycles: number of unlock cycles. An unlock cycle is the dispensing of small

quantities before the actual purge starts, to facilitate the pump or valve unlocking.

. Unlock quantity: set the dispense quantity for the unlock cycles.
. In some dispensers, the quantity is not set in ml, but in number of steps forward
and reverse.

. Unlock speed: set the unlock cycle speed.

. Alert time: set the purge alert time.

For further information on the purge parameters settings, please refer to the chapter
“dispensers”.
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Login levels management
Two login management modes are available in TintWise:

. Level mode
o A different password can be set for each level.
o) By default, three levels are available.

Operator: no password is set. Only basic operations are possible. This is the
software starting level.

. Technical: no password is set. Only maintenance and calibration operations
are possible.

. Service Tech/administrator: password is “Producer”. Complete access to all
of the available features.

. Operator mode

o An operator list can be added to each level.

o Operators log in with their name and a custom password.

o) By default no operator is set in TintWise.

Click the “Login” button to access the login window. If operators are set, the operator login will
open, otherwise the level login will open.
These windows can also be accessed from the main window (File-Login).

IAdministrﬂtur LJ

8 ., 9

P P [ r
L LS g {m i)

Picture 38: Level login
Click “Logout” to go back to the starting level.

To change the password for the current level, click “File-Login-Change password” in the main
window.
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Change password - Service Tech

Current password

MNew password

Confirm new password

I -

Picture 39: Change password

The current password must be entered once; the new password must be entered twice.

NOTICE: No password can be set for the starting level.

Login organization:

Depending on the login level used to access the software, more or less functions are available. The
configuration can be changed from the main window: Tools-Organize login.

From this window is it possible to:

. Add/Remove/Change a login level.
. Add/Remove/Change an operator.
. Change the passwords.

It is possible to change only the settings of login-levels lower than the current level.

IE! 7
Repart Ckrl+R
Skatistics

Options

Picture 40: Tools menu
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Administrator

Level Operators
: Service Tech

=§ Operator

Picture 41: Login management

Right-click to see the available options.

Level
E Scrvico Tecnf
Add
ﬂ Operator
Modify
Remove

Picture 42: Login level options

Add: adds a new level

Change: enables/disables some features in the selected level.
Remove: removes the selected level.

Password: sets a password for the selected level.

PwwnNpE
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Modify level - Service Tech

[v Allow login level management [v Allow mangement of operators
[~ Automatic shut down [v Show desktop
v Show dispenser settings v Allow dispenser settings change v Show manual commands
¥ Show maintenance v Show data v Show options
v Canisters: Allow direct level change [~ Canisters: Allow level alarm change v Canisters: Show Full/Empty buttons
v Cani : Show ad d opti v Canisters: Allow calibration v Cani: - Allow col t/canist iati h
[~ Cani - Allow izt pacity ch [~ Canisters: Allow steps alarm settings change [v Canisters: Allow puige alarm settings change
[v Allow ignore purge alert [v Allow manage custom formulas [v Show New/Edit formula buttons
[~ Allow Logo/Information change [~ Allow customize colorants [ Allow customize cans
[~ Allow advanced settings [~ Allow export data ¥ Show Price button
v Show Print label button v Allow manage dispense queue v Allow create advanced search
v Allow use advanced search [~ Allow standard datab [~ Allow manage purge advanced settings
~ ©
1] 4 Cancel

Picture 43: edit level

In the edit level window (Picture 43) features can be checked or unchecked to change the selected
level. The entries are reviewed in the appendix D.

Operators management:

Operators are listed in the right side of the Login management. Right-click in the operator area to
view the available options.

Login management

Administrator

Level Operators
ﬂ Service Tech
a Operator

Picture 44: Add operator
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Paul

s 9

Ol Undo

Administrator

Level
ﬂ Service Tech % :
ﬂ Operator | Add

Rermonve

Change level

v

(114

Picture 46: Operator password

The operator is saved on the selected level, which can be later changed by clicking “Change level”.
Depending on the access level given to the operator login, more or less functions will be available.

If operators are added, the “Login” button in the main window opens the Operator Login window.
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Paul

o

Ol

Undo

Picture 47: Operator login
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Software options

The software options window can be accessed from the Tools-Options menu in the main window,
where

TintWise can be customized according to the different user's needs.

The window is divided into categories. More or less sections might be available depending on the
login level.

General parameters:

l | |
General ] “ "

' Language

|English v

ﬁ Colorant quantity
A

[] Show creation date in Formula

[] 5how formula notes

? [[] Show base quantity
B

[] Show formula notes confirmation window |
Show formula color
Selection grids: automatic Alter if not found
Show Remove the can message

Manage customers
Always show customer zelection before dizpenze

Manage formula percentage
Allow typing of random percentage

[] Show formula percentage icon on main page

Standard formula selection mode Gnds zelection mode
| Default v | Double Click |
E.m .:-_g
{b Save Cancel
Picture 48: General paramters
. Language: select the display language for TintWise.
. Show creation date: if checked, once the formula is selected, it will be possible to view the
creation date, the list of colorants and their quantities in the detail window (see picture 49).
. Show base quantity: if checked, the base quantity will be shown in the formula detail.
. Show formula notes: if a formula has one or more notes, they will be shown during the for-
mula selection.
. Show formula notes confirmation window: if enabled and if a formula has one ore more

notes, TintWise will show a confirmation window before to start a dispensing.
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. Show formula color: if the information about the finished color of a formula is stored into
the database, it will be shown during the formula selection.

. Selection grids: automatic filter if not found: if enabled and during a selection you write a
not recognized code, pressing enter it becomes automatically a selection filter. Otherwise an ad-
vise message will be shown.

. Show Remove the can message: if selected, the message will be shown at the end of every
dispensing.

. Manage customers: if selected, you will see the customer selection button in the main
page.

. Always show customer selection before dispense: if selected, the customer selection page
will be shown before every dispensing.

. Manage formula percentage: enable/disable the formula percentage management (see the
note here below *). If disabled, the related button will be never displayed.

. Allow typing of random percentage: if enabled, it will be possible to type the percentage,
otherwise it will be possible only to use the percentages from the list.

. Show formula percentage icon on main page: show the formula percentage button in the

main page, to use it directly on standard and custom formulas. If disabled, the button will be dis-
played only on New/Modify formula window.
. Standard formula selection mode:
o Default: the selection of the formula code is done on the last selection level, so
after selected all other information (product etc.).
. On level [x]: the selection of the formula code is done on the selected level.
For selection modes different by Default, TintWise will use the advanced search indexes, if
they don’t exist, TintWise will automatically ask to create them.

. Grid selection mode
. Double click
. Single click

Using the buttons it’s possible to customize the color of the text and the background in the
formula detail for every selected item.
The customization will happen by the following window.

Customize color ]

Text color

Back color
‘ x:'f;w':. default

Preview

Ml [ P Ty |
@ dalit el
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C4 - Colorant 4 : 12,284 ml
C11 - Colorant 11 : 155,155 mil
Cl1 - Colorant 1: 3877,111 mil

Picture 49: formula finished color view

(*) Formula percentage

Clicking on the percentage button it is possible to multiply the colorants’ amounts of a

formula by a percentage.

Riproporzionamento foarmula E

10,00 %

fax
50 X%
2hE
125 %
10 &
hE
o

+h X
+10 %
+125 %
+25 %
+50 X%
+5 X
+100 %

A 9

Ok @ Annulla

Picture 50: Formula percentage

42



Units of measurement:

|

| Unit of measurement [ "

Colorants

ml v
Base

|Lt v|

Canister level

| Lt w |
Add

| Lt L |
Capacity

| Lt v |

a ., 9

Save Cancel

Picture 51: Unit of measurement

The units of measurement listed in the drop-down menus can change depending on the
corresponding details. See paragraph Units of measurement. It is possible to customize the units
of measurements used to view data by:

. Components: views the quantity of colorants in the formula, add formula from the

New/edit window.

Base: views the quantity of base in the formula.

. Canister level: views the levels in the canisters window.
. Filling-up: adds filling-up quantity.
. Capacity: views capacity in the canisters window.

If a fractional measurement unit for colorants is selected, it’s possible to set the maximum number
of fractions to be viewed in formula view.
This kind of displaying is quite useful when using manual dispensers.
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| Unit of measurement |External formula | External commanc

Colorants

/46 AmericanFioz |9

Show more fractions in formula view

Max fractions

Base
|Lt v|

Canister level

| Lt w |
Add

| Lt v |
Capacity

| Lt w |

A ¢ 9

Save Cancel

Figura 52: Show more fractions
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In fig. 50 example the formula view will be as follows.

C4 - Colorant4: 0 Y+ 2 1148 2 1196
Cl12-Colorant 12: 0 Y+ 42 1\48 1 1\96
C13-Colorant 13: 0 Y+ 13 1148 2 1\96

Cl-Colorant1: 1Y+ 26 1148 2 1196

Figura 53: Formula view with many fractions.
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View price:

| |
l

| | View price

Mumber of available dizcounts

| " |
Tax
|n,nu % ‘
Price markup on base

|u,uu % ‘

Price markup on colorants

|u,uu % ‘

E‘.m .:-_2_
{b Save Cancel

Figura 54: View price
. Number of available discounts: it will be possible to apply one or more discounts to the
formula’s price.
. Tax: tax is added automatically to prices.
. Price markup on base: the base price will increase on a given percentage.
. Price markup on colorants: the price of colorants will increase on a given percentage.

If the double price management is enabled for the database, in this page you will have the
possibility to insert two different “VAT” and two different markups (both for colorants and bases).
Se il database prevede la gestione dei doppi prezzi, in questa stessa pagina si avra la possibilita di
inserire due “IVA” e due ricarichi (sia per coloranti che per basi) distinti.
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External formula:

|

| | External formula |

[J Use external formula

External formula path

| )

[C] Entire Folder

External formula file name [specify file extension)

[] Add external formula in Dizpenze queue

Format

| Change ]

Reduce to icon after dizpense

Warn if not recognized

Save Cancel

Picture 55: External formula

TintWise can import formulas from a text file or an external formulation or color management
software. TintWise must be instructed on where the file is stored.

. Use external formula: importing from external software is enabled.

. External formula file name: the path and folder where the formula text file is stored.

. Entire folder: if checked, all files in the folder will be read and added to the dispense
queue.

. External formula file name: name of the swap file (if Entire Folder is unchecked). It must be

used when the external software replaces the same file again and again. Most formulation and
color management softwares work this way.

. Add external formula in Dispense queue: if checked, the external formula is not loaded and
dispensed, but added to the dispense queue.
. Format: the swap file format. Select the correct format by clicking the “Change” button.

Formats may change depending on the program in use.
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w. Jext file format
Farmat list

CTR.FMT
Datacolor FMT
DoubleSeparatorTes
DoubleSeparatorTes
DoubleSeparatorTes
Eurovernici. FMT
ExtCommands.FMT
FranchiKim FMT
Italcrom FMT
Italcrom_Am_FMT
LargoTint FMT

Miltonia.FWMT
Mix2Win FMT
+ X
Mew Delete

Format preview
Camponent code |

General parameters ] Heading Enmpnnents] Last mw]
MName File extension
|Default B

" Fised size field
* Separator char
Field delimiter
Blank word identifier
Formulation type

* By wolume
" By weight

v Absolute
(" Percentage

Conversion factors

B
Ii
li

Total quantity 100
Components quantity .00
Baze quantity 11,00

B aze infarmation

" Only product

" Only baze type

Baze + baze type [zame field)

Baze type + bazse [zame field)

Mohe

-

Cormpohents
[~ Fixed Mo.

~
~
" Baze type and baze [zeparated fields]
(v
r

Mo. of componentz |5

Campanent quantity |

Save

% Canhicel

2240472010 18.22

Figura 56: External formula format

Minimize after dispense: if checked, TintWise minimizes after every dispense and returns

to the external formulation software.
Warn if not recognized: if the file is read correctly but some colorants are not found within
the available ones, a warning message is displayed.
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External commands:

[A

[Unit of measuremen ' " a| ila | External commands

[J Use external commands

External commands path
|[Z:\.HEHI]_5W\.D ata\ExtCommandsz\ L@

INPUT file name [zpecify file extension]
|INPUT.dat |

OUTPUT file name [zpecify file extension]
|I]UTPUT.dal |

PROCESS file name [specify file extension]
|PHI]EE55.dat |

a 9

Save Cancel

Picture 57: External commands

TintWise can be set to work as a driver, thus receiving commands from external software through
text files. For more information on the ASCII protocol used, please contact HERO.
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Main window title

|Tint'w'ise

MRADATTVE DOLOF FETMWCLOTE

FHERG B

[JUze custom logo
Stretch logo

Information
HERDO Europe sil

Fraz. Buretto, 12/A - 12041 Benevagienna [CH]
Tel. +39 0172 654866

Fax +33 0172 654887

E-mail address
|eu.hem@ue.hem.-::a |

Web zite [:
|http:Heu.hem.-::a |

a 9

Save Cancel

Picture 58: Logo

The main page logo (upper right corner) can be customized with a personal/business logo.
Information are later displayed in the ?-information window.
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Advanced:

| I |
| | Advanced
Check maintenace at startup [] Enable autodetect can size
Start with last selected formula Always show conlirmation window
Threshold
[[] Change Custom database for each configuration 1.00 %
Columns in Hew\Modify window 100.00 g
|2
Custom formula fields
1 |Key1
) |KeyZ
3 |K31.13
Dispenser
E‘.m .:-_ﬂ_
Save @ Cancel
Picture 59: Advanced
. Check maintenance at startup: check to show/hide the maintenance request at software
startup.
. Start with last selected formula: on startup, the last selected formula is shown. If
unchecked, on startup the first level of the standard formula is displayed.
. Enable AutoDetect fill level: the fill level is automatically detected with the scale

connected, by weighing the can and the base already present in the can. If checked, the
AutoDetect fill level voice is added to the formula selection. A scale is required for this feature to
be active.

o Always ask for confirmation: ask for confirmation once the fill level is detected.

o Threshold: tolerance threshold for the fill level detection.

. Change custom database for each configuration: if different configurations are used, it is
possible to choose whether to keep a custom database shared among the configurations.

. Columns in New/edit window: if long descriptions are required for the colorants, viewing

the window “New/edit formula” by grouping all colorants on a single column might be very useful.
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. Custom formula keys: edit the number of the memory keys to be used in the custom
formulas.

. Custom formula key description: the keys description can be edited. The descriptions are
shown in the column headings in the custom formula section.
. Dispenser: the dispenser driver currently in use.
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Prices management

Prices can be in the standard database or can be added/modified directly from TintWise. Prices
depend on some data/settings:

. Colorants prices: price/liters or price/weight.
. Base price: price/liters or price/weight.
. Can price: the absolute can price. The can is intended for a defined selection, so its price

will include the previously weighed base already added for a specific product. If “can price” is
checked, the price on liters or weight will be ignored because it is already included.

. Fixed price of a formula: if a fixed price is set for a specific formula, all other data are
ignored.

. TAX: added to the final price (see Software options).

. Markup on base: value added to the base price (see Software options).

. Markup on colorants: value added to the colorants price (see Software options).

It’s possible to select the can size directly from this page to see its price using the related menu.

After selecting a formula, click “Price” in the main window to view the price.

Prices
5 Lt vi
Base £ 125,00 ~Discount
Colorants £ 8,65 0.00 %
0.00 %
Total £ 133,65 0.00 %

Picture 60: Price
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If one or more discounts are set, they will be determined automatically.

Prices

b Lt w
Base £ 125,00 ~Discount
Colorants £ 8,65 10,00 %

0.00 %

Total £ 133,65 0.00 %
- 10% £ 13,37
Total £ 120,29

Picture 61: Discount

If markups of taxes have been added in the Software options page, it is still possible to view the
final price or cost before markups or taxes are actually added.
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Base
Colorants
+ 20%

Total

€ 137,50
€ 9,51
€ 29,40

€ 176,42

5Lt w
~Discount
0.00 %
0.00 %
0.00 %

{®) view price
I[:]I View Cask

Picture 62: Price

Prices

Base
Colorants

Total

€ 125,00
€ 8,65

€ 133,65

5Lt w
~Discount
0.00 %
0.00 %
0.00 %

{:} View price
(%) View Cost

Picture 63: Cost
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If the user's login level allows prices management, in the same window a “change” button will be
added to open a customization window for the selected formula.

Prices
5 Lt v
Base £ 137,50 ~Discount
Colorants £ 9,51 0.00 %
+ 20% £ 2940 0.00 %
0.00 %

Total € 176,42

{*) View price
{7 Wiew Cost

il

Change Exit

Picture 64: Price

Actual price 3b22¢

Formula fixed price -1 Lt

Base B? -1 Lt

Base B? 35.00 /Lt v

D

Colorants Cancel

Picture 65: Prices customization

Prices customization can also be accessed from the File-Data-Prices menu in the main window.
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ZIEW Dispenser utilities  Tools 7

Zolorants

Cuskormize

Unit of measurement | Cans

Export data

Create advanced search
Standard database management
Add Canfiguration

Picture 66: Prices menu

Prices |E
Il ¢ - colorant 1 2500 [g/t -
B c2 - cotorant 2 3200 [ent =
B 3 - colorant 3 4600 [ejr ~
I ¢4 - colorant 4 56.00 [g/Lt -

C5 - Colorant & 112.00 £/t -
B cs - cotorant 3200 [g/x -
B c7 - colorant 7 1500 [e/r =
B cs - colorant 8 1100 [enx
I co - colorant 9 5400 [enr
Bl cio- colorant 10 6700  [enr
C11 - Colorant 11 132.00 m
¢z colorant 12 3200 [ern =
Bl ci3-colorant 13 54.00  [e/r
Bl c14-colorant 14 5500  [enr o]
Bl ci5- colorant 15 2300 [e/n <
Bl ci6 - colorant 16 2200 [e/r -
A 9
Ok Cancel

Picture 67: Colorants/components prices

Prices ]
B1 25.00 IE,-"Lt vI
B2 3500 g/t ~
B3 1500 [ene -]
& 9
@] Cancel

Picture 68: Base prices

u
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Collection 1
Product 1
1Lt 0.00
2.5 Lt 0.00
b Lt 0.00
15 Lt 0.00
25 Lt 0.00

=

Apply to
Collection

Picture 69: Can prices

The cans available for a given product can be accessed as described for the standard formula.
Then the absolute price of a can may be set; the price is later used as base price.

If the double price management is enabled for the database, in all the pages described in this
chapter you’ll have the possibility to see two different price, depending on a quick selection
button.
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Maintenance

At TintWise startup, after the connection with the dispenser, the software checks if some
maintenaces are needed. If yes, it shows following page.

Maintenance

Maintenance Information

[] wet cap zponge Completed: 04/11/2009 16.26
Clean cap Completed: 041172009 1626
Purge Canisters in purge alert: 8

{*) Purge canisters in alert
() Purge all

Figura 70: Maintenance

The maintenaces to be done are highlighted in yellow.
* Wet cap sponge
o You must wet the cap sponge, to avoid the colorants become dry on the nozzles.
e Cleancap
o You must remove, clean and replace the cap.
* Purge
o You must purge the colorants. Depending on the option below, it will purge all can-
isters or just the ones in purge alert. You can see the list of canisters in alert on the
second column.

Clicking “Next” TintWise will follow you with a wizard to do the maintenances.
The procedure may be different depending on the dispenser.
Here an example of some wizard’s pages:
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Remove the cap for cleaning

Press Ok when done

—Automatic cloze in—

W [18 min  55sec |
OK .

Figura 71: Clean cap required

Dispense

Insert can

o 9

QK Undo

Figura 72: Purge can required

Work in progress

Purge circuits

Please wait

X

STOP

Figura 73: Purge circuirs in progress



measurement menu.

Unit of measurement

Units of measurement
All Units of measurement can be customized in TintWise by opening the File->Data->Units of

g
Lt

Ka

American FL 0F

1/48 American FL 02
1/96 American FL 02
1/192 American FL 02
1/384 American FL 02
Metric FL 02

1/48 Metric FL 02
1/96 Metric FL 07
1/192 Metiic FL 0Z
1/384 Metic FL 0Z
Impenal FL 02

1748 Impenal FL 02
1/96 Impenal FL 02
1/192 Impenal FL 02
1/384 Impenal FL 02

[

Code

mil

Description

ml
Factor
1.0000000000 (& ml
Oa
Fraction [] Symbol

Decimal places

Preview

B

0.000 ml

5
Add

Remove

A ¢

OK

93

Cancel

Picture 74: Unit of measurement
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Unit of measurement

mi

g

Lt

Kg

American FL 02

1/48 American FL 02
1/96 American FL 02
1/132 Amernican FL 02

[

Code

£

1192 American FL OZ

Description

Factor

SRS SR

17384 American FL 0Z
Metric FL 02

1/48 Metric FL 02
1/96 Metric FL 02
1/192 Metic FL 02
1/384 Metic FL 02
Impenal FL 02

1748 Impenal FL 02
1/96 Impenal FL 02
1/192 Impenal FL 02
1/384 Impenal FL 02

29.5700000000

{3 ml
Oa

Fraction

Symbol

192

¥+

Decimal places

Preview

B

Y+ 0.0

5
Add

Remove

=

OK

5

{b Cancel

Picture 75: Units of measurement

During the installation a database of the most common units of measurement is created.

Click the buttons in the left lower corner to add or cancel units.

Code: memory code.
Description: the description is shown on the right side of the number displayed.
Factor: multiplying factor, on milligram or gram base.
Fraction: dividing factor (used for ounces).

Symbol: if needed, what symbol is placed between the whole and decimal part of a

number.
Decimal places: the number of decimal figures to be displayed.
Preview: preview the unit of measurement.
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menu.

Customize colorants

Customize/Add colorants
The list of the available colorants can be opened from the File->Data->Customize->Colorants

C1 - Colmant 1

C2 - Colorant 2
C3 - Colorant 3
C4 - Colorant 4
C5 - Colorant 5
C6 - Colorant 6
C7 - Colorant 7
C8 - Colorant &
C3 - Colorant 9
C10 - Colorant 10
C11 - Colorant 11
C12 - Colorant 12
C13 - Colorant 13
C14 - Colorant 14
C15 - Colorant 15
C16 - Colorant 16

Code
C1

Description

Colorant 1

Specific weight

1.5640000000 gfml

Color

External code

'
Add

Remove

A 9

(@] {r_n) Cancel

Picture 76: Colorants window

The “External code” is an alternate code used to identify the colorant, useful if TintWise is
connected to other software. More external codes can be set by typing them in the same text
field, separated by a semi-colon.

Example: Col1;,Comp1

Notice: the colorants listed in the standard database cannot be removed.



Customize/Add cans
The list of the cans available can be opened from the File->Data->Customize->Cans menu.

Customize cans

1Lt Code
2.5 Lt 1Lt
5Lt
i Description
25 Lt
1Lt
Can capacity Tare
1.00000 Lt 0.000 Kg
Default quantity
1.00000 @ Lt
Okg
Type
E} EBase quankity
() Finished product [] Always shown
Detfault order priority
0
External code
[l -
P — & 9
Add Remove 0K i Cancel

Picture 77: Cans window

. Code: memory code.

. Description: description for the selected can to view in TintWise.

. Can capacity: the can capacity in liters.

. Tare: the weight of the empty can.

. Default quantity: it is the quantity used to recalculate the formulas. If set on zero, then the
can capacity is used.

. Type:

o Base quantity: formulas will be recalculated on the set base quantity.

o) Finished product: the formulas will be recalculated so that the sum of Base and
colorants is equal to the quantity set.

. Always shown: if checked the can is automatically associated to all products.

. Default order priority: a higher value means a higher priority for a can during the selection.
For same priorities, the order will be by capacity.

. External code: alternative code or codes used for external connections to other software.

Notice: the cans listed in the standard database can't be removed.
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Labels

Click the “Labels” button (or press F5 on the keyboard) in the main window to print a label.
Set the number of copies and click print. The printed data will depend on the selected formula and
the user's setting.

Print label %
|

=

Print Cancel

Picture 78: Print label

Standard and custom formulas can be printed with different layouts. Go to the File->Data-
>Customize->Labels menu to edit layouts.

4L |StandardLabel INI v
Add Description Auto-print mode
| Default | |Never V|
Printer l Reset l Left offset Top offset
| System default printer u Chansa ”I] HI] ‘
| 4 Rows Eant
Row 1 }Arifﬂ [ﬁ.]
Fow 2
Aol Field 1
|Shup Name v|
Field 2
| v
Field 3
| o
= Field 4
Print | v
g Field 5
Preview | bl |
Erg ->_§
Save Cancel

Picture 79: Label layout
The margins settings depend on the printer in use. Usually they can be set to zero.
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The printer and its settings can be modified by the related button. The button “Reset” set TintWise
to print on the system default printer.

The “auto-print mode” can be set:
1. Never: you have to click the related button to print a label. This will never be printed auto-
matically.
2. Before each dispensing: the label will be printed before every dispensing.
After each dispensing: the label will be printed after every dispensing.
4. All at once before dispensing: all the labels will be printed automatically when clicking “Dis-
pense” button.
5. All at once after dispensing: all the labels will be printed automatically after filling a certain
number of cans.
The “Print label” button in the main page will be always available and it will not depend on the
chosen option.

w

Set the number of lines first, and then define each line by selecting it on the grid, and then the text
to be printed and its font.

Up to 5 fields can be added to every line.

All text present in the text fields will be printed as typed.

If a voice is selected from the drop-down menu, the information text will depend on the selected
formula.
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Customnize labels 3]

i |StandardLabel.INI v
;ﬂ‘dd Description Auto-print mode
| Default iNever bt |
Printer l Reset Left offset Top offset
| System default printer u ERanas ”I] il] ‘
| 4 Rows Font
Row 1 }Arlal [J"—‘:\;]
Row. 2
Row3. ~|0Bold Size ‘"1
Feowh Field 1
v
[Price]
[Pail Code]
[Custom information]
[Date]
[Tab] L
[Formula]
[Base] bt
Py
< Field 4
Print | v|
e Field 5
e
Preview | b |
E- _‘m r:—§.
Save Cancel

Picture 80: Customize labels — select field

Click “Preview” to preview the printed label. Click “Print” to print a test label. In both cases
random data will be used for the printing operation.
Click the “Add” button to create a new layout file.

Dispense queue
Both standard and custom formulas can be added to the dispense queue. To do that, select them
and click “Add to queue” instead of “Dispense”.
The button may be available only with the appropriate login level, but the queue can be
completed at operator level as well.

In the “Dispense queue” section, click the “Dispense” button to view the details about the queue.
Double-click an element to edit it.

You can view the queue order by schedule or priority.
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| Standard [ m | Dispense queue (3) |Search

| Formula |Canz | Comment | Type | Scheduled

1 | Collection 1\Product 1% 1 | Standard |
 Base B2: 15 Lt I | |

2 | Collection 1\Product 1% | 1
Baze B2: 1 Lt |
| 402
3 | Collection 1\Product 1% [1
| Base B2: 1Lt
| 403

Picture 81: Dispense queue

Standard

Standard ‘

Left-click the column heading to edit the order criteria.

Right-click a column heading to choose from a list of view options.

| Standard [ Custom | Dispense queue (1) |Sea

| Formula Canz | Comment |Type Scheduled J Priviity

1 | Collection 1\Product 1% 11| | Standard | v Formula
|

| Baze B2: 15 Lt | |
“i i v 2ans

Dispensed cans
v Camment
v Tvpe
v Scheduled
Creation

Picture 82: Dispense columns

The “Dispense queue” section appears when at least one dispense is in queue, and disappears
when the queue is completed. The number of processes currently in queue is in brakes next to the
Dispense queue heading.

The dispense queue is kept in memory even if TintWise is shut down.

Export Data

Data can be exported from dispenser to dispenser, both for data exchange and backup purposes.
A backup is recommended after every important operation.
Click the ‘File->Data->Export data’ menu in the main window to open the export data window.

#=8 Dispenser utilities  Tools 7

Prices L4
Zustarmize 4
Logout IInit of measurement

Export data

Create advanced search
Standard database management
Add Configuration

Fom L- :
Picture 83: Export data menu
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An auto-installing file (.exe) is generated after the export process. The file can later be used to
install the exported data to another PC running TintWise.

Output path

|E: \E xport

Output file name

myE xport

Description

|T est exportation|

Quick selection

| Custom exportation

Standard databaze

Include Advanced Search

Custom databasze

Software options

Login configuration

Dispenszer configuration [canisters, settings]
Dispenser calibration

[ ] Dispenser local data

[ ] Dispense reports

& 9

Save {*_”} Cancel

Picture 84: Export data

* Output path: where the file is stored.
e Output file name: name of the output file.
* Description: it can be viewed during the installation.
* Quick selection
0 Custom exportation
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0 Complete exportation for other dispensers: it will select all information useful to use
the exportation to install another dispenser, with same characteristics of the one
currently in use.

0 Complete back-up: all information will be exported, also the ones related only at the
dispenser currently in use.

Information exporting options:

* Standard Database

* Software options

* Login configuration

* Dispenser configuration

Canisters configuration, associations and dispenser parameters.

* Dispenser calibration

* Dispenser local data
0o Colorants level present in the canisters, dispenser wearing data.

0 These data are related only at the dispenser currently in use.

* Dispense reports
0 Completed dispenses data.

* CTX
0 Available only if an automatic CTX agitator is present.

Click “Save” to start the export routine. Export time depends on the amount of data and the
file size.

The options above are also available during the setup of the output file, so that only part of the

output data can be installed if necessary.

See the installation procedure in the following screenshots.
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X

Welcome to the HERO
Datalnstaller Setup Wizard
Thiz will install Demo D atabasze for Tinbwize on your computer.

[t iz recommended that vou cloze all other applications befare
continLing.

Click Mest to continue, or Cancel to exit Setup.

Picture 85: Exported data setup

Select Components
YWhich components should be installed™? L

Select the components vou want to install; clear the components you do not want to
ifiztall. Click Mest when you are ready to cantinue.

Full inztallation

Standard databasze 2.3MB

Current zelection requires at least 2.3 MB of dizk space.

[ ¢ Back ” Mt > ][ Cancel

Picture 86: Exported data setup
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Completing the HERD
Datalnstaller Setup Wizard

Setup haz finished inztaling HERO Datalnstaller on pour
conputer.

Click Finizh to exit Setup.

Picture 87: Exported data setup

Further update files can be accessed from the TintWise LAB database and installed as described
above.

Report and statistics

Report:

The dispensing data will be saved to allow next use.
The report page is available from the main page in “Tools”->"Report” menu.
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Filter
From Customer
| 07/08/2009 - [Custamer 3 3
To —
] . = =
| 07/08/2008 = Process &
Formula Cans Customer Type Date
Collection 3\Product 1 1 Customer 1 Standard 0770972009 11.47.59
B1: 1Lt
405
Collection 3\Product 1 1 Customer 1 Standard 07/09/2009 11.48.05
B1: 1Lt
405 [
Collection 3\Product 1 1 Customer 2 Standard 07/09/2009 11.48.33
B1: 1Lt
405 i | oy
Collection 3\Product 1 1 | Customer 2 | Standard 07/09/2009 11.48.38
B1: 1Lt
405 | | | |
Collection 3\Product 1 1 Customer 3 Standard 0770972009 11.48.55
B1: 1Lt
405 [
Collection 3\Product 1 1 Customer 3 | Standard 07/09/2009 11.49.05
B1: 1Lt
405
A '
Loy
Detail Dispense Exit

Figura 88: Report page

You can filter the list datas by period and customer changing the related text boxes and clicking
“Process”.

After selecting a row from the displayed list it’s possible to recall a formula to make a new
dispensing clicking on “Dispense” button. The formula will be loaded in the main window as a
custom formula.

It’s possible to look at the real selected production report after clicking on “Detail” button.

The selected formula and the real can by can dispensed quantities will be displayed. If the
dispensed quantity is different from the desired one, the percentage error will be displayed.

If dispensing has been made using a scale, the displayed quantities will be exact. On the contrary if
a volumetric dispensing has been made virtual quantities will be displayed.
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Report

Collection 1\Product 1
B1: 25 Lt

405

Customer 2
117082009 16.22.53

Scale: No

Formula

C4 50.430 ml

ci2 569.782 ml

C13 159,196 ml

C1 1341.267 ml

Can no. 1

C4 50.430 ml

ci2 569.782 ml

C13 0.000 ml -100%
C1 1341.267 ml

Can no. 2

C4 50.430 ml

ci2 569.782 ml

C13 0.000 ml -100%
C1 1341.267 ml

Can no. 3

C4 50.430 mli

[£

Figura 89: Report detail
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Statistics:
The statistics page is available from the main page in “Tools”->"Statistics” menu.

il Statistics |;| |E| le
File

Options
Filter
From 08/08/2009 - To 07/09/2009 "

Process for

(&) Colorants () Bases + Cans

{1 Bases () Products + Cans

{3 Cans (" Products + Bases

{3 Products () Products + Bases + Cans

{_) Formula Keys

Exportto CSV Exit

Figura 90: Statistics

After selecting the time period and the desired option, click on “Process” button to display the
statistics graph.

A CSV file will be created clicking on “Export on CSV”. In this way you will be able to view all the
dispensing data of the selected time period.
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5]

raph
~Options
Yiew Order
&Lt (&) Descendent
OKg ) Ascendent
) Number of cans
Graph 1
= i @l @ % [¥] Legend ]Value - |Bars
__________________________________________ ...t | [=m7.033C Colorant1
7 : : I 2,006 C12 Colorant 12
| H B 1,466 C3 Colorant 3
: : 0,385 C8 Colorant 8
------------------------------------------ e B 0.292 C2 Colorant 2
G I : I 0.234 C4 Colorant 4
i 5 Il 0.136 C7 Colorant 7
i : Il 0,125 C15 Colorant 15
------------------------------------------------------------------- oooeesieeioeeeccooocioooooooooooo 0,07 C13 Colorant 13
= : : B 0,041 C6 Colorant 6
PR [ e
I T e T
Al B ' e T
o - - s

ol
1 Colorant 1

3 Colorart 3

C2 Colorant 2 C7 Colorant 7

13 Colorant 13

Exportto Excel

Figura 91: Statistics graph

The same values can be displayed on graph, in a list or exported on a excel file.
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Standard database advanced management

Whenever an update is installed, the previous database is not erased so it's still available for the
user. To view the list of databases installed and/or select a new one, open the File->data-
>Standard database menu.

Databases

S1D 1.0.0 Path: STD

] sTD_11.00 :Zéﬁﬁc:rlptmn: STD1.0.0

g 5TD_2 1_I_].I] Creation: - not set -
STD_31.00

¢ | = a 9

Add Remove oK Cancel

Picture 92: Standard database management

Notice: the running database cannot be removed.



Multiple configuration

TintWise can run multiple configurations. A configuration is intended as the list of software
options. If configurations are added, the relating buttons appear for a quick selection.
Example:

Viewing formulas in different units of measurement might be useful at times. Therefore a

configuration can be created for each unit of measurement to convert different units very quickly.

To add a new configuration click “File->Data->Add configuration’ in the main window.

Configuration E|
[nizert new name
Cancel
Configuration 4

Picture 93: Add configuration

If more configurations are present at the same time, buttons will be added for each one.

& Configuration|
C Configuration 2

Configuration

Picture 94: Select a configuration

To select a configuration click the corresponding voice.
Right-click to rename or remove a configuration.
Notice: the current configuration cannot be removed.

® Configurationl

O Configuration 2 | FRename
Remowve

Configuration |

= |

Picture 95: Configuration options

The lower button shows the name of the running configuration (Pictures 94 and 95). Click the
button to hide/view the configuration selection window.
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Software licence

TintWise expires 120 days after setup, unless activation is made. Warning messages will pop up
during the last 30 days before expiration.

Notice: if no license is purchased, TintWise will stop working. We highly recommend purchasing
a license before the trial period expires.

An activation code is required for the software activation. Send your request code to HERO to
receive your activation code. Activation is necessary on every PC running the program. To proceed
with the activation the following data are required: request code, type and dispenser serial
number.

To activate follow the menu ?-activate. When the expiry date approaches, pop up warnings will
remind the user to activate, with a link to the menu ?-activate.

File Dispenser utilities Tools n
Help

m Infarmation

Activation request code

65429958

e

Reqgister i E =it

Picture 97: Activation code

The code in the example above must be sent to HERO along with the dispenser serial number for
the activation code to be released. Then click “Activate” and enter the received code.

Software driver registration

Enter activation code

Cancel

Picture 98: Activation code
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Dispensers

Instructions differ according to the dispenser in use. The common pages are listed below.
TintWise can manage the following dispensers:

. Archimede
. Eureka

. Newton

. Teo

Some features (like dispense strategy, volumetric calibrations and connecting a scale to the PC)
are common to all types of dispensers, so they are discussed at the end of the present chapter.

Archimede/Eureka

Software operations in Archimede and Eureka are the same, so they will be discussed in the same
chapter. Both machines are available in a sequential and simultaneous version, but the difference
is clear during TintWise operations.

Note: the word “speed” refers to the speed necessary to start a circuit. That speed is always shown
in percentage of the highest speed limit.
0% means the lowest possible speed.

Basic system requirements

Besides the requirements listed in the first chapter, the following are present:
. connection to the dispenser

o) Up to a 16 canisters: 1 USB port.

o) Above 16 canisters: 2 USB ports.

. connection to the scale

o) 1 serial port (a USB to serial port connector can be used if the port is not available -

but in this case one more free USB port becomes necessary).

Setup

The PC controls the dispenser through the USB cord (2 cords for the versions with more than 16
canisters). As always, window requires installing the proper drivers for the USB ports.

When the new device is found, window informs the user that “New hardware found” and start the
driver setup.

Click “Install” after inserting the TintWise installation CD to automatically complete the drivers
setup.
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Found New Hardware Wizard

Thiz wizard helpz vou install zoftware for;
USE Port

'J} If your hardware came with an installation CD
2= or floppy disk _ inzert it now.

What do you want the wizard to do?

() Irstall the: software automatically (Fecommended)
(O Install from a list or specific location [Advanced)

Click Nest to continue,

< Brack ” Mext » ][ Cancel

Picture 99: Drivers setup

If more drivers are needed, various setup operations may be required. We recommend all
necessary drivers are properly installed.

Connection
On startup, TintWise will attempt to connect to the dispenser.

E e -

Controlling data
Loading data
Connecting
Autodetect

Picture 100: connection

This stage usually takes a few seconds, but it may take longer depending on the PC hardware and
performance, and the dispenser equipment.
When the first connection is established (or in case of anomalies) the following window opens.
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Digpenser configuration E]

Canisters
16

{#) 1 electronic board (max 16 Canisters)
{2 2 electronic boards {max 24 Canisters)
Electronic board 1
P

Serial port Sernal port
| 1 v)

Retry in demo mode

Picture 101: connection

When the first connection is established, the number of canisters present in the dispenser must be
set.

Machines with more than 16 canisters require two electronic boards. Depending on the
equipment available, the Serial Port field might display a number or the word MPUSB. Changing
the preset values may be necessary only if TintWise cannot AutoDetect them.

Buttons:

. Ok: try again to connect

. Undo: exit software

. Retry in demo mode: open TintWise in demo mode, that is with no PC-dispenser
connection.

After clicking OK the AutoDetect tool may open, to verify the connection quality.

dispense

A volumetric calibration must be done for every circuit before dispensing.
For each dispense the dispenser will run the following operations.

1. Colorant dispensing

2. Waiting time

3. suck back

After every dispensing a drop always remains within the nozzle. Waiting is necessary for the drop
to be stabilized (a shorter or longer time depends on the products used), then the suck back can
be run, in order to suck the drop back into the nozzle. The ability to repeat a dispense effectively
strongly depends on the waiting time and the performance of the suck back.

The waiting time is the time it takes the drop to become completely still in its position before the
suck back starts.

The suck back brings the drop 1 mm back into the nozzle.

These parameters can be customized for every circuit (see paragraph Calibration).
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If the dispenser is connected to a scale and set to work along with it, the dispense procedure is
more complex. For the necessary weight to be reached, some dispenses will be made while
keeping the scale under control. To achieve a higher precision level, the final part of the dispense
should be done drop by drop.

Calibration

Calibration is the procedure necessary for a series of dispenses volumetric and to set the
parameters for the suck back.
The calibration parameters can be viewed in the canisters window, under the Calibration section.

Notice:

We highly recommend performing some tests before setting the calibration, in order to evaluate
the quality and settings of the suck back.

The parameters that can be changed manually are:

. Quantity of suck back: General section

. Waiting time: Threshold section (line by line editing).

For further information on the parameters above, please see the following sections.
A scale is always needed to run a calibration. TintWise can connect to most scales on the

market. Nonetheless, data can be added manually, but the calibration process will take much
longer.
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Calibration settings

Eeneral- I " |

»

Beginning purges
| 2 |

Min quantity
| 0,077 mi |

Max tolerance
| 0500 ml |

Suck back quantity
| 3.00 Dropz |

Suck back zpeed
| 0,00 % |

Global Factor
| 1.00000 |

Picture 102: General calibration parameters

Usually, only the quantity of suck back needs to be edited.

. Beginning purges: the number of purges needed before running a calibration.

. Min. quantity: minimum quantity needed for the calibration.

. Max. tolerance: maximum tolerance allowed for calibration data to be considered valid. It
is taken into consideration only when the percentage set in the thresholds volumetric is higher.

. Suck back quantity: the quantity that will be sucked back.

. Suck back speed: speed to during the suck back.

. Global factor: K Factor as to the ideal pump. It is automatically determined during the
calibration.
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Canmister detail % |

a @ 0 & S w2

Add Full Empty Purge Advanced purge Calibrate
il:1 Colorant 1 w

114

Levels

144

Purge settings

»

Calibration settings

| [ Drop [Thresholds |

Stepsz
| 7.00000 |

Quantity
| 0.02000 ml |

Speed
| 0.00 % |

Threzhold
| 0.000 ml |

Waiting ime
| 3.00 sec |

Last drop waiting time
| 700 sec |

Picture 103: Drop calibration parameters

A drop is the smallest quantity the dispenser can produce for a specified product. This quantity
varies depending on the product characteristics and it is determined automatically during the
calibration process.

In the drop section no changes are necessary except in the case of gravimetric dispensers.

. Steps: the number of steps it takes the pump to dispense a drop. It is automatically
determined during calibration.

. Quantity: quantity of a drop in ml. Automatically determined during calibration.

. Drop settings:

o Speed: the pump speed during the fine drop dispensing.

o Threshold: below this value a fine drop dispensing is required.

o) Waiting time: waiting time between on drop and the next during the fine drop
dispensing.

o Last drop waiting time: waiting time after the last fine drop dispensing, before the

suck back starts.
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Canister detail %]

> @ B0 & Al 2

Add Full Empty Purge Advanced purge Calibrate
|E1 Colorant 1

Levels

Purge settings

| L LL £

Calibration zettings

[ﬁ[ﬁ Thresholds

Buantity Speed Tolerance W aiting time | Factor
1 |033ml 0% 10% | 3 sec 0.8992
2 [3ml 10 % 5% |3 sec | 0.8992
3 [10ml |30 % 1% | 3 sec | 0.8992
4 |50mi 60 % 1% |3 sec | 0.8992

= ==

Add Remove

Picture 104: parameters calibration thresholds

The average default threshold usually applies to all products, so it may be necessary to edit only
the waiting time value.

Hereby the calibration settings are set. During the dispenses — depending on the dispensed
quantity — either thresholds settings are used.

Examples in Picture 104:

. a 0,2 ml dispense uses threshold 1 parameters.

. A 1,5 ml dispense uses threshold 2 parameters.

. A 30 to 75 ml dispense uses threshold 4 parameters

Parameters:

. Quantity: quantity required to define a threshold.

. Speed: speed for the dispenses within this threshold.

. Tolerance: tolerance limit to consider calibration data acceptable.
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o) Notice: this tolerance level does not depend on the dispenser's precision, but it is
taken into account only during the calibration process. A low level corresponds to a slower
calibration. Please remember that slower doesn’t mean more accurate.

. Waiting time: waiting time before dispenses suck back within this threshold.
. Factor: K Factor referred to the ideal pump. It is determined automatically during
calibration.

Click “Calibrate” in the canisters page to calibrate a dispenser.

Calibration 1

C1 Colorant 1 é
Specific weight Connect scale
TS
I3
[ Drop EE
@ Fast l'est Dispenses
{1 Advanced

Thresholds
{s) Fast
{1 Advanced

Autodetect suck back wait time

o 2

Calibrate Exit
Picture 105: calibration
Buttons:
. Scale connection: opens the Scale connection window.
. Test dispenses: opens the Test dispenses window to verify the quality of the calibration.
. Calibrate: starts calibration.
. Exit: closes the window.
Settings:
. specific weight: the specific weight in the standard list is automatically set, but if a

difference is known, the value can be manually modified; all changes will not be permanent.
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. Drop: enable the drop calibration; the pumps rotates once or more, very slowly, for the
product to be dispensed drop by drop. Counting the number of drops may be requested during
the calibration. The drop parameters are later determined on the number and weight of the drops

dispensed.

o Fast: 1 rotation. It's usually enough for a quick calibration.

o Advanced: 4 rotations.

. thresholds: start calibration of the parameters from the thresholds section.

o) Fast: One 50 ml dispense, which influences all the thresholds. Use the quick
calibration only to “fix” an existing calibration.

o Advanced: the selected thresholds are calibrated. Use the advanced calibration

before a dispenser calibration. It may be avoided only if data from a previous calibration (from a
dispenser with the same configuration) have been installed.

Press the “Calibrate” button and calibration will start automatically.

At the beginning you will be asked to enter the capacity of the can you are using, so that the
dispensed quantity can be contained in that can. If the calibration is done with a low end scale, it is
necessary to set the can capacity so that the low end is never exceeded.

Confirmation instructions are required only in case of:

. drop calibration: count and enter the number of drops produced during the
calibration.
. Filling-up the canister or replacing the can when necessary.

During the calibration a graphical preview of the current test is shown on the right side of the
screen. At the end, a confirmation message is displayed.

For further information on the volumetric calibration, see Appendix A at the end of this chapter.
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Dispenser settings
Click the Dispenser management menu in the main window to access the dispenser parameters.

Digpenser settings

i .': 1| "1
General | [ || |

Driver mode

ﬁ)emu vi
Canisters
16 |
Agitation Equipment
Time on Can sensor
| 3 min 0sec | Cap

Time off
|15|] min 0 sec |

OK Undo

Picture 106: General dispenser parameters

. Driver mode:

o Demo: TintWise runs with no connection to the dispenser.

o Connected: TintWise is connected to the dispenser.

. Canisters: number of canisters. When this option is modified a new connection is required.
. agitation: the dispenser has an agitator for each canister, so as to keep the product fluid.

The agitation cycle works even when the PC is turned off and is automatically paused during the
dispenses and when the Manual Commands window is open.

o) Time On: how long the colorants must be agitated.

o Time Off: how long it must be waited between agitation cycles (with no further
agitation).

. Equipment:

o) can sensor: enable/disable the can sensor management to check if a can is present
under the dispense head.

o cap: enable/disable the cap management.

o Cap and can sensor are found in all dispensers. They can be disabled to avoid

damages of in case of failure.
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Digpenser settings

General | Scale | [ Pumes |

[] Automatic connection

[] Use scale for dispensing

OK Undo

Picture 107: Dispenser settings /Scale

In most cases, the dispenser works in volumetric mode, so no scale is required except for
calibration. Enabling an automatic connection to the scale can be useful in the following cases:

. Ponseral dispenses.
. Fill level auto detection tool.
. Automatic calculation of the filling-up quantity with a scale.

Using a scale can help test the quality of the dispenses, but we recommend you refer to the Test
dispenses window.

Software add-ons must be installed if gravimetric dispenses are needed. In that case the
gravimetric dispenses parameters will be added to the window in Picture 107.
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[General | Scale | |[Pumes |
Automatic connection
Usze scale for dispensing
{7 Only control
{*) Gravimetric autocalibration
Tolerance Max calibration deviation
| 1.000 % | | 5.000 % |
| 0.500 ml | | 0.200 ml |
Threshold Security
| 10,000 ml | | 1.00 % |
Enable combined dizpensing
[] One step combined mode

QK ‘{h_’J Undo

Picture 108: Dispenser setting / scale

These parameters are available only if more software is added for a gravimetric dispense.

. Only control: dispenses are volumetric, but a report with the quantity dispensed will be
viewed at the end of every dispense.
. Gravimetric autocalibration: enable gravimetric dispense with gravimetric autocalibration.

Gravimetric dispense:

. tolerance: the dispense stops when it is within tolerance level. To be within tolerance, the
error margin from the target value must follow both a percentage and an absolute parameter.

o) Examples in Picture 108:

o) 100 ml

= percentage tolerance: 1% =1 ml

= absolute tolerance: 0,5 ml.

. The dispense will be in a tolerance range between 99,5 and 100,5 ml.

o) 1mil

n percentage tolerance: 1% = 0,01 ml

= absolute tolerance: 0,5 ml.

= The dispense will be within a tolerance range between 0,99 and 1,01 ml.

o Notice: if the error is lower than half the minimum dispensable quantity (drop) as
calculated during calibration, the dispense is validated within tolerance.

. threshold: auto calibration starts below this threshold.

o With the auto calibration the dispense is split into two parts; the second half will be
calibrated once the first calibration is over.

o) Usually the auto calibration is not necessary, so we recommend setting this value
quite high, at about 50 ml.

. Max auto calibration deviation: maximum deviation tolerated in the first dispense half to

consider the data valid.
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. Security: the dispense never aims directly at the target value, but always a little below. This
value is expressed in a percentage. The higher is the parameter the more secure and slower the
dispenses. A balance must be found between precision and speed for every specific need.
Examples in Picture 108.

dispense 100 ml.

100 ml—1 % =99 ml.

First dispense 99 ml. We assume the dispenser has dispensed the exact quantity.

1 ml remains.

1ml—-1%=0.09 ml.

Second dispense 0.09 ml.

The dispense stops because it is within tolerance.

. Enable combined dispense: a combined dispensing is a way to dispense that does a gravi-
metric test in the first can, saves the auto-calibrated data and use them on next cans, that will be
dispensed in volumetric, so quicker. It’s very useful on simultaneous machines. The autocalibration
is done in two steps, ignoring the Security setting. If after the second step the requested weight is
still not reached, the dispensing will be completed in gravimetric and the test will be repeated on
next can. If the required amount is smaller then the threshold, the dispensing will be always done
in gravimetric.

. One step combined mode: if enabled, the two steps saved during the gravimetric test will
be merged in one dispensing. It might be quicker but, depending on the product, it might have less
precision repeating the dispensing.

| || -I M aintenance ]. |

O O O 0O 0O O O O

Aszk to wel cap sponge every Fill up dizpensze tube
| 22 h 0min | | 20 sec |
Wet cap sponge hime out Speed
| 5 min Osec | | 85,00 % |
Aszk to clean cap every Empty dizpense tube
[160 h O min | | 40,00 ml |
Clean cap time out Speed
| 15 min 0 sec | | 25.00 % |
Cleaning cap on middle pozition
Middle position time out
| 1.50 zec |

? {T} Undo

Picture 109: Maintenance dispenser parameters

* Ask to wet cap sponge every: maintenance frequency.

* Wet cap sponge time out: maximum time to complete the maintenance.
e Askto clean cap every: maintenance frequency.

* Clean cap time out: maximum time to complete the maintenance.
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¢ Clean cap in middle position: not available for all dispensers. Allow to complete the main-
tenance with the cap in middle position instead of completely opened.

e Middle position time out: time to reach the middle position.

* Pipes maintenance: These parameters should not modified unless necessary, because they
affect the Fill-up/Empty tube window.

o Fill pipe

o Speed

o Empty pipe
o Speed

Digpenser settings

[Scate | [ Pumps |

Acceleration
| 1000 Step/zec™2 |

Deceleration
| 750 Step/sec™2 |

Boost time
| 3.00 sec |

Start speed
| 15.00 % |

QK Undo

Picture 110: Dispenser settings /pumps

Changes to these parameters are usually not necessary.

. Acceleration: pumps acceleration.

. Deceleration: pumps deceleration.

. Boost time: how long double current is given to the pumps engine at the beginning of the
operations.

o) Notice: when working with simultaneous dispensers, the circuits will not start at the
same time, so that double current is never given to two engines at the same time.

. Start speed: starting pump speed.
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Purge parameters

For specific information see the purge paragraph.

Archimede/Eureka also make a purge during the run-in period. The parameters set for the run-in
will replace the standard parameters for about the first 5 liters dispensed.

The unlock cycles can be set in number of steps forward and reverse.

Advanced settings can be used for the purge process.

Canister detail [

> @8 0 & & w2

Add Full Empty Purge Advanced purge Calibrate
|E1 Colorant 1 v|

Levels

»

Purge settings

Mormal | Advanced Running in

& &
Unblock cycles 1 Times 3 Times 1 Times
Forward . 14 steps 14 steps . 14 steps
Reverse . 14 s.teps . 14 s.teps . 14 s.teps
Unblock speed | 0.1 % 0.1 % 0.1 %
Quantity | 0.5ml 2ml 0.5 ml
Speed | 25 % | 25 % | 25 %
Advanced settings | Mo Mo . Mo
Alert time | 20h 72h | 20h

0.85 h zince last dispensze

14

Calibration settings

Picture 111: Purge parameters

The advanced settings have been implemented to manage very critical colorants, which tend to
separate the liquid from the solid part quite quickly. Double click the corresponding cell in the grid
to access the advance settings.
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»

Purge settings

| Hormal | Advanced | Bunning in .

3 F |
Unblock cycles 1 Times .“-3”1.'imes 1 Times
.Fumard 14 steps 14 steps 14 steps
Reverse 14 steps 14 steps 14 steps :
Unblock speed | 0.1 % 0.1 % 0.1 %
Quantty | 05ml N [ 0.5 ml :
Speed | 25 % | 25 %
Advanced zettings Nn 3 Yes No .
Alet time 20k [72h |20k

Picture 112: advanced settings

The example in Picture 112 shows how the advance settings replace the normal settings. Double
click the cell in the column with - - to access the advanced settings window.

Advanced settings [®]
| Quantity | Speed | Motor direction | Suck back
1 |oim oz | Forward 5
2 [01m IEE: | Forward o]
3 |[05ml |20 % | Forward o
4 [31.42m |20 % | Reverse O
5 [34.42ml |80 % | Forward ]

Insert Add Remove

i

o 9

QK Undo

Picture 113: advanced settings
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All steps are run in a sequence. Steps can be added or removed. Double click the selected value to
edit it.

For each step the following settings are possible:

. quantity: reference quantity.

. speed: pump speed.

. Motor direction: forward = dispense, reverse = suck back.
. suck back: run the suck back procedure.

The purge can be configured as desired. In the example in Picture 113 two small dispenses are
made at low speed with a suck back aimed at unlocking the pump, then a small 0,5 ml purge, and
then the tube is emptied by sucking the colorant back into the canister, which is later re-filled at
high speed in order to restore the optimal operating conditions.

Notice: we highly recommend using the advance settings only for very critical colorants, because
most colorants do not require setting changes. Emptying and re-filling operations can cause air
to remain in the tube, thus limiting future repetitions of the dispense.

Test dispenses

Click the Dispenser management — Test dispenses menu in the main window to access this feature.

Canister Component code [ # %
01 | ¥
0|2 C2 Add Remove Connect scale
Ol 3 C3
1l s c4 | Buantity Times Work time
10 ml 3 30 min 0 sec
Ols s vl
D B CE | 1ml 3
| Pause time
0.1 ml 3
07 Lt ! 10 min 0 sec
Ol
8 cs
HIE:] Ca | Aqgitation
]| 10 C10 | 0 min 30 sec |
O 1 Ci1
J)12 c12 l Change can for each
0l13 C13 colorant
|14 Cl14
| 15 C15
0| 1. C16 ® mi o
Oug R
resuits
Start Exit

Picture 114: test dispenses

A sequence order can be set for a list of dispenses. A scale must be connected for a report to be
viewed after running the tests. The reports are saved as text or .xls files.

96



Autodiagnostic

An auto diagnostic tool is run to verify that cap and can sensor work properly. Click the dispenser
management — auto diagnostic menu in the main window.

Can sensor x|

Unblock the can sensor

9

Undo

Picture 115: Can sensor autodiagnostic

Cap

Remove cap

9

Undo

Picture 116: Cap auto diagnostic

TintWise verifies the sensors' status. If they don't work correctly, click “undo” to cancel the test.
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Manual commands

Every part of the dispenser can be commanded from the Manual commands window. This can be

very useful in case of problems and maintenance.

P Manual commands

BEAEAARARRR G

LStatus

IAgitatiun ‘

|F"umps on ‘

|24 Vdc @

IAIEII ‘ |Ha-::hine in ztop

Mo Alarm-
Commands
Aaqgitation Pumps
_\@"_ Canizter selection
On 1-C1 - Colorant 1 j
@ Speed zelection
Motor direction —
Forward j -,@:

..............................................

Picture 117: Manual commands

The buttons On/Off start or stop and action. Agitation, cap or pump are controlled from this

window. The sensors’ status is displayed above.

To activate a pump, select it from the drop-down menu, select its speed and click ‘On/Off’.
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Pipes maintenance

Before running a Maintenance on the dispenser, we recommend to empty the tube and fill it up
again once the Maintenance is done. Everything can be done with the manual commands, but the
page below shows how to follow the automatic procedures.

/4~ Maintenance

ISpensetube

1

Ispensetube

Exit

Picture 118: Maintenance
. Replace canister: procedure to replace a canister. At the end all wear data are reset.
The procedureallows to
o empty the tube.

Replace the canister with a step-by-step guide.
o Fill-up the dispense tube.
. Fill-up the tube: start the procedure to fill-up the tube. The pump is activated at high speed
so that all air is removed while filling-up occurs.
. Empty tube: start the procedure to empty the tube used to suck the tube's content into the
canister.

99



Automatic firmware update

During the connection with the dispenser TintWise checks the firmware’s version installed on the
electronic board. If a more recent version is available the software will ask to update.
The update is completely automatic and it takes few seconds. Normally it doesn’t require any
operation by the user.
Only in particular situations following operations could be asked to the user during the update.
* Turn OFF the dispenser, wait for 10 seconds and click Ok.
* Turn ON the dispenser, wait for 10 seconds and click Ok.
To turn OFF/ON the dispenser you can use the relative button on the machine.
Notice: don’t click Ok before the required operation has been completed.
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Newton

Software operations in Archimede and Eureka are the same, so they will be discussed in the same
chapter.

Note: Speed refers to the motor speed. Speed is always shown as a percentage of the maximum
speed allowed.
Speed 0% is the lowest speed allowed.

Minimum system requirements
Besides the requirements listed in the first chapter, the following are necessary:

. dispenser connection

o) 1 serial port (if not available, a USB to serial port converter can be installed, but in
this case a further serial port is needed).

. Scale connection

. If the dispenser has an internal scale, no further port is required, otherwise another port is

needed (if not available, a USB to serial port converter can be installed, but in this case a further
serial port is needed).
. 2 PS/2 ports for mouse and keyboard.

Installation

No further drivers must be installed because the dispenser is connected to the PC through a serial
port. If the PC doesn’t have a serial port, a USB to Serial converter must be used.

Connection
On startup TintWise attempt to connect to the dispenser.

Connecting with dispenser

Controlling data
Loading data
Connecting

I 407
Picture 119: connection

The operation time depends on the PC performance and the dispenser’s equipment. During the
first connection and in case of anomalies, the following page is displayed.
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Digpenser configuration

Canisters Electronic board @

20 Serial port

Picture 120: connection
On the first connection it is necessary to set the number of canisters present in the dispenser.

Since the auto detection is active, the serial port number in the specific field is usually correct.

Buttons:

. Ok: attemps to connect again

. Undo: exit the software

. Retry in demo mode: open TintWise in demo mode, without any connection between PC

and dispenser.

Dispense

Volumetric:

If the dispenser has not a scale, the only possible dispense will be volumetric (based on the
encoder).

The dispense can be simultaneous, but only if the dispensing speed of the colorants is the same.
TintWise will list the colorants during the dispense depending on their dispense speed.

Gravimetric:

the gravimetric dispense is always sequential (except when a colorants is given to more circuits,
where a simultaneous roughing-out is made). During the entire dispense TintWise communicates
with the scale.

The gravimetric dispense is based on the concept of queue, where “queue” is the quantity of
product present in the circuit when the valve gets closed. All calculations made on the queues are
multiplied for a security factor, because a queue can never be perfectly constant.

Gravimetric dispenses are done in three steps:

1. High speed: in order to reach the required weight as quickly as possible, the dispense starts
at high speed. The speed is then reduced as the weight limit approaches, with a queue calculated
at high speed.

2. Low speed: the dispense then goes on at low speed. The valve gets closed when the weight
reaches a value very close to the set value, with a queue calculated at low speed.
3. Finishing or Correction: a series of small volumetric dispenses to reach the final weight.

These dispenses are always based on a security factor, so that the limit weight is not exceeded
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Obviously, depending on the quantity to be dispensed, the dispense may start from point 2 or 3.

Combined:

In the combined dispense, during the dispense of the first canister, a sequential auto calibration is
made on the set dispenses. For the next dispenses of the same formula (if the auto calibration was
positive), the dispense will be volumetric (colorants are dispensed simultaneously).

The auto calibration is made in two steps:

In the first, the first half of the set quantity is dispensed with a volumetric calibration, then the
weight displayed on the scale must be read to calculate the volumetric dispense for the second
half. All data are later saved for the following dispenses of the same quantity.

Calibration

The calibration consists in running a series of automatic dispenses and changing the parameters
settings in case of a gravimetric dispense.

The calibration parameters can be viewed in the canisters window, in the calibration settings
section.

»

Calibration zettings

General |

Global Factor
| 1.02651 |

Minimum calibration guantity

| 0.077 ml |

Phyzical tolerance

| 01509

| 0 zteps

Tolerance
| 1.00 % |
| 0.50g |

Picture 121: Calibration settings - general

The only parameters to be modified in this section refer to the tolerance levels. These levels will
influence only the dispenses made with a scale (gravimetric and combined).
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. Global factor: K Factor referred to the ideal pump. determined automatically during

calibration.

. Min. guantity: minimum quantity needed for the calibration.

. Physical tolerance: if the difference between the weight of the dispensed product and the
target weight is lower than the physical tolerance level, it is always considered within tolerance.
. tolerance: the dispense stops when it's within tolerance levels. To be considered within
tolerance, the error margin from the target value must meet two parameters: percentage and
absolute.

o Examples in Picture 121:

o 500 ml

n tolerance percentage: 0,5% = 2,5 ml

. absolute tolerance: 0,5 ml.

= dispense is within tolerance between 9,5 and 100,5 ml

o 1ml

. tolerance percentage: 0,05% = 0,005 ml

. absolute tolerance: 0,5 ml.

. dispense is within tolerance between 0,85ml and 1,15 ml because physical

tolerance occurs, since it's higher than the tolerance.

Calibration settings

General Elﬂ‘ll'il.llEt.li[: ]ﬁ

2

~Gravimetric low speed
Tail
| 3449 |

Security factor
| 200 |

Speed
| B.00% |

Calibration quantity
| 10.00 ml |

~Gravimetric high speed
T ail
| 1580 g |

Securty factor
| E.00 |

Speed
| 80.00 & |

Calibration quantity
| 50,00 ml |

~Yolumetric intervention
Security

| 10.00 % |

Threzhold
| 10.00 tails |

Autocalibration threshold

| 10.00g |

Autocalibration tolerance

| 5.00 % || 0.20g

Picture 122: Gravimetric calibration parameters

The parameters in this window refer to gravimetric and combined dispenses, and they do not

influence the volumetric dispenses.
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gueues are determined automatically during calibration. The other parameters must be set
appropriately for a good balance between precision and speed.

. gravimetric high speed

o) queue: the quantity of product present in the circuit when the valve is closed at
high speed. determined automatically during calibration.

o Security factor: multiplying security factor for the queue. Once the final weight is

reached (Factor * queue), speed will decrease to “low speed”.
The higher is the factor, the more secure and slow is the dispense.

o speed: high speed.

o Calibration quantity: quantity to be dispensed to calibrate the queue.

. gravimetric low speed

o) gueue: the quantity of product present in the circuit when the valve is closed at
high speed. determined automatically during calibration.

o Security factor: multiplying security factor for the queue. Once the final weight is

reached (Factor * queue), speed will decrease to “low speed”.
The higher is the factor, the more secure and slow is the dispense.

o Speed: low speed.

o Calibration quantity: quantity to be dispensed to calibrate the queue.

. Volumetric intervention (finishing or correction)

. Security: the dispense never aims directly at the target, but always a little below. This value

is expressed in percentage. The higher is the parameter the more secure and slower are the
dispenses. A balance must be found between precision and speed for every specific need.

= Examples in Picture 122.

. 100 ml dispense.

. 100 ml =10 % =90 ml.

. First dispense 90 ml. We assume the dispenser has dispensed the exact
quantity.

= 10 ml remain.

. 10 ml—10% =9.9 ml.

. Second dispense 9.9 ml.

o The dispense stops because it's within tolerance.

o Threshold: below this threshold you can directly start a volumetric intervention
instead of high or low speed dispenses. You can set the number of times a low speed queue is
repeated.

. Threshold: auto calibration starts below this threshold.

o) With the auto calibration the dispense is split into two parts; the second half will be
calibrated once the first calibration is over.

o Usually the auto calibration is not necessary, so we recommend setting this value
quite high, at about 50 ml.

o) tolerance auto calibration: max deviation tolerated during the first half of the

dispense for the output data to be considered valid.
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2

Calibration settings

. Thresholds |

Quantity Speed Tolerance Factor
] 1 ml 8% 10 % 1.29688
. 1 10 ml 30 % hx 1.06217
: 2 100 ml 80 % = 1.02651

Picture 123: parameters calibration thresholds

The average default threshold usually applies to all products.

Hereby the calibration thresholds are set. During the dispenses — depending on the dispensed
guantity — either thresholds are used.

Examples in Picture 123:

. a 0,5 ml dispense uses threshold 0 parameters.

. A 1,5 ml dispense uses threshold 1 parameters.

. A 30 to 150 ml dispense uses threshold 2 parameters

Parameters:

. Quantity: quantity required to define a threshold.

. Speed: speed for the dispenses within this threshold.

. Tolerance: tolerance limit to consider calibration data acceptable.

o Notice: this tolerance level is not connected to the dispenser’s precision, but is taken

into account only during the calibration process. A low level corresponds to a slower calibration.
Please remember that slower doesn't mean more accurate.
. Factor: K Factor referred to the ideal pump. Determined automatically during calibration.

Click “Calibrate” in the canisters page to calibrate a dispenser.
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Calibration 1

C12 Colorant 12

Specific weight
[ oo |

Gravimetnc high speed

Gravimetnc low speed

Thresholds
) Fast
(=) Advanced

M1-1ml
M 2-10ml
] 3-100 mi

& 3

Calibrate Exit
Picture 124: calibration
Buttons:
. Scale connection: open the Scale connection window. The button is available if an internal
scale is not present.
. Calibrate: start calibration.
. Exit: close the window.
Settings:
. specific weight: the specific weight in the standard list is automatically set, but if a

difference is known between the theoretical and real specific weight, the value can be manually
modified and used for the calibration; all changes will not be permanent.

. gravimetric high speed: enable the high speed queue calibration. If an internal scale is not
available, the option is disabled, because only the volumetric calibration will be needed.

. gravimetric low speed: enable the low speed queue calibration. If an internal scale is not
available, the option is disabled, because only the volumetric calibration will be needed.

. thresholds: enable calibration parameters in the thresholds section.

o) Fast: a single 100 ml dispense, which influences all the thresholds. Use the fast

calibration only to “fix” an existing calibration.
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o Advanced: the selected thresholds are calibrated. Use the advanced calibration for
the first calibration of the dispenser. It may be avoided only if data from a previous calibration
(from a dispenser with the same configuration) are installed.

Press the “Calibrate” button and calibration will start automatically.

Fill in the capacity field for the can in use, to check that the dispensed quantity can be contained in
that can. If the calibration is done with a low end scale, it is necessary to set the can capacity so
that the low end scale is never exceeded.

Confirmation instructions are required only in case of filling-up or replacing a canister.

During the calibration a graphical preview of the running test is shown on the right side of the
screen. At the end, a confirmation message is displayed.

For further information on the volumetric calibration, see Appendix A at the end of this chapter.
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Dispenser settings
Click the Dispenser management menu in the main window to access the dispenser parameters.

Dispenser settings

General l ” l
Driver mode
i Demo Yi
Canisters
20 [
Agitation E quipment
Groups Speed ESn i
' 30 %
! 2 = H | Automatic Cup
T s Clozsing waiting time
| 7 min 0 zec | | 2.500 zec |
Time off Automatic elevator movement
. Down movement Time out
| 30 min 0 zec | r -
| Each production % || 20 zec |

Picture 125: Dispenser settings - general

. Driver mode:

o) Demo: TintWise runs with no connection to a scale.

o) Connected: TintWise is connected to the dispenser.

. Canisters: number of canisters. When this option is modified a new connection is required.
. agitation: the dispenser has an agitator for each canister, so as to keep the product fluid.

The agitation cycle works even when the PC is turned off and is automatically paused during the
dispenses and when the Manual Commands window is open.

The agitation time is equally divided among the current agitation groups. The motor runs all the
time to guarantee the colorants flow.

o Groups: number of agitation groups.

o Speed: motor speed during recirculation.

o Time On: how long the colorants must be agitated.

o Time Off: how long it must be waited between agitation cycles.

. Equipment:

o) can sensor: enable/disable the can sensor management to check if a can is present
under the dispense tap.

. cap: enable/disable the cap management.

. Time out: how long before the cap is closed after the dispense is finished.
o) Automatic elevator movement: enable/disable the elevator management.

if checked, after the “insert can” message is displayed, the elevator will go up to the can sensor.
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. Movement down: manage the elevator descent.

. None: no automatic movement.

. Every can: at the end of every dispense.

. Every dispense: after every dispense (for more cans of the same
formula).

= Time out: max. time range for the elevator movement to occur. If the up or

down movement should take longer, an alarm will be displayed.

Digpenser settings

Dizpenszing type

i Combined w |

Dispensing order

i Small quantity first w |

{) Mo scale

(&) Internal zcale

| M ettler w

K.eep Combined values for
| 240 min |

Picture 126: Dispenser parameter / Scale

. Dispense type: select the dispenser type:

o volumetric

o gravimetric

o combined

NOTICE: if no scale is present, the only type available is “volumetric”.

. Dispense order: order mode for the formulas being dispensed.

o None: no order.

o Small quantity first: the colorants with small quantity settings are dispensed first.
o) Large quantity first: the colorants with large quantity settings are dispensed first.
. scale:

o No scale: no scale connected.

o) Internal scale: the dispenser has a scale.

. Mettler.

= Gibertini.

. Keep combined values for: how long the gravimetric test values for a combined dispense

must be kept in memory, in case the dispense is repeated.
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Dispenser zetling=s

[ " [ Maintenance l—]

Azk to wel cap sponge every
[ 20 h Omin |

‘wet cap sponge time out

| 5 min 0sec |

Ask to clean cap every
| 160 h 0 min |

Clean cap time out

|15 min 0 zec |

Figura 127:Maintenance

* Ask to wet cap sponge every: maintenance frequency.

*  Wet cap sponge time out: maximum time to complete the maintenance.
e Askto clean cap every: maintenance frequency.

* Clean cap time out: maximum time to complete the maintenance.
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Digpenser settings

| [scate | | Pumps |

Initial recirculation time

| 4 zec |

Minimum zpeed
| 6% |

Maximum speed
| 100 % |

Dizpenszing/recirculation mazimum speed
| 80 % |

Picture 128: Dispenser settings / Pumps

e |Initial recirculation time: sets how long the motor should run before the valve is opened,
before the set speed is reached. Editing this parameter is usually not necessary.

*  Minimum speed: it’s not possible to move the motor more slowly then the minimum
speed.

* Maximum speed: it’s not possible to move the motor more fast then the maximum speed.

* Dispensing/Recirculating maximum speed: Maximum available speed for dispensing and
recirculation. If the set value is bigger then maximum speed it will be ignored.
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Caristers | Extemal canisters settingsl Multicanister thresholdsl

Circuit Colarant Capacity Current Level [Lt] | Current Lewvel [%] {\EitTimum Level Minimurn Level (%] | Advise Level (L] | Advise Level [%)] External

» ci1z 20.0 Lt 16.6 Lt 83.0 % 2.0Lt 10,0 % 3.0Lt 15.0 % |}

ol 2 C? 20.0 Lt 14911 Lt 74565 % 2.0Lt 10,0 % 3.0Lt 15.0 % r
3 C3 20.0 Lt 9.962 Lt 49.81 % 2.0Lt 1000 % 3.0Lt 15.0 % r
4 Cc9 20.0 Lt 18.632 Lt 93.16 % 2.0 Lt 10.0 % 3.0 Lt 15.0 % O
5 C13 20.0 Lt 17.025 Lt 85.12 % 2.0 Lt 10.0 % 3.0 Lt 15.0 % 0
3 c2 20.0 Lt 17.996 Lt 89.98 % 2.0 Lt 100 % 3.0Lt 15.0 % r
vy c2 20.0 Lt 17.987 Lt 89.93 % 2.0 Lt 100 % 3.0 Lt 150 % O
8 c10 20.0 Lt 18.614 Lt 93.07 % 2.0 Lt 100 % 3.0Lt 15.0 % O
9 C1 20.0 Lt 17.941 Lt 89.7 % 2.0 Lt 10.0 % 3.0Lt 15.0 % r
10 Ci 20.0 Lt 179356 Lt 89.67 % 2.0Lt 1000 % 3.0Lt 15.0 % r
11 C15 5.0 Lt 2.987 Lt 59.74 % 0.5Lt 10,0 % 0.75 Lt 15.0 % r
12 Ch 10.0 Lt 8.985 Lt 89.85 % 1.0Lt 10,0 % 1.51Lt 15.0 % O
13 Cl16 10.0 Lt 6.99 Lt 69.9 %% 1.0Lt 10.0 %% 1.5Lt 15.0 %% (i
14 C11 5.0 Lt 2.985 Lt 59.71 % 0.5 Lt 10.0 % 0.75 Lt 15.0 % r
15 C8 20.0 Lt 15.329 Lt 76.65 % 2.0 Lt 10.0 % 3.0 Lt 150 % O
16 o] 20.0 Lt 15111 Lt 75.56 % 2.0 Lt 100 % 3.0Lt 15.0 % O
17 C14 5.0Lt 23214 46.41 % 0.5 Lt 10.0 % 0.75 Lt 15.0 % r
18 C4 500.0 Lt 80.366 Lt 16.07 % 50.0 Lt 100 % 75.0 Lt 15.0 % 2
19 10.0 Lt 0.0 Lt 0.0 % 1.0 Lt 100 % 151t 150 % |
20 5.0 Lt 2938 Lt b8.76 % 0.5Lt 1000 % 0.75 Lt 15.0 % O

Picture 129: advanced settings

The canisters data can be modified in this window. If external circuits are present in the dispenser,
click “External canister” to enable them”.
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il Advanced Settings

Eanislers1 Esternal canisters settings  Multicanister thresholds

Yolumetric threshold

100 ml

Gravimetric threshold

[ 50.0 mi

Gravimetric security

[ 200 ml

Combined threshold
30.0 ml

Save @ Exit &

Picture 130: advanced settings

If one colorant is used on more canisters, the dispenses will be optimized by dispensing it from
two valves at once. The optimization occurs only when the dispense quantity exceeds the
threshold. This threshold can be set in this page, according to the dispense type.
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il Advanced Settings

Canisters  External canisters settings | Multicanister thresholds |

Pump load
capacity

c4 [8.0 Lt 7.996 Lt [0.8 Lt 10.0 % [ 15.0 Lt/min

o i Intemal Current Intemal Minimum | Intemal Minimum :
Circuit Colarant Internal Capacity Level [Lt] Level [Lt] Level (%] Agitatar group

Save Exit &

Picture 131: advanced settings

If external circuits are present, this is the window to change the parameters of those circuits.

Autodiagnostic

An auto diagnostic is run to verify the can sensor and the automatic cap (if present) work
correctly. Click Dispenser Management — Auto diagnostic in the main window to set the auto
diagnostic.
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Can sensor

Unblock the can sensor

Picture 132: Can sensor autodiagnostic

Cap

Remove cap

9

Undo

Picture 133: Cap auto diagnostic

TintWise verifies the sensors' status. If they don't work correctly, click “undo” to cancel the test.
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Manual commands

Every part of the dispenser can be commanded from the Manual commands window. This can be
very useful in case of problems and maintenance.

ManualCoromands X
Encoder Can Sensor Weight
0 & 0
Tare E_"}l
Cupper &8 EV
1 _Off |9 | off W17 [ Off |
i 2 Off 10 Off 18 Off
Agitator 1 @ | [3 off | [11 off | [19 Off
Agita’mr 2 8 4 Off 12 Off 20 Off
=) Off 13 Off
5] Off 14 Off
7 Off 15 Off
8 Off 16 Off
up  fe
Stop  EX
Down Close All  &| lgnore Sensors Ql
Motor Q|
|
(KRR N N NN RN TR R R RV R RN f}:l llllllllllllllllllllllllllllllllllllllllllllllll 1
Exit §|
StandBy
Picture 134: Manual commands
. Encoder: view the number of steps counted by the encoder.
. Can sensor: view the can sensor status.
. Cupper: available only for Newton with automatic cap. it opens and closes the cap and
views the status of the open sensor.
. Agitator N: start/stop an agitation group.
. EV: open/close the dispenser valves. If the dispense cannot be made (for example: because

a can is not present), the buttons are disabled, unless the Ignore Sensors mode is on.

. Close All: closes all the valves.

. Ignore Sensors: the valves can be opened even when the security sensors (cap and can
sensors) are in alert and block the operations..
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Motor: start/stop the selected pump motor.
Exit: exit the window.
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Appendice A: Calibration strategy and volumetric dispense

in the HERO dispensers

The technology used for the volumetric dispenses differs from dispenser to dispenser, but the
basic concepts are the same for all models.

A volumetric dispense does not require a scale (needed during the calibration) and can be done
simultaneously on more circuits if the dispenser can handle the process.

Thought the calibration data, the software can determine the steps needed to dispense a given
quantity. The steps can be managed through the step motors (Archimede/Eureka) or an encoder
on the transmission (Newton/Teo).

Two parameters must be held into account when calculating the steps:

1. the characteristic of the product to be dispensed, which can influence the linearity of the
dispenses and the performance of the pump, depending on their speed. Calibration test are made
to determine how the various products react according to the speed.

2. The pump's characteristics. The calibration will determine a K factor, that is a multiplying
factor indicating the flow rate difference from the ideal pump.

The software features two dispense types:

. advanced calibration: determines both the product-related data (point 1) and the K factor
(point 2) through a series of tests.
. Fast calibration: determines only the K factor (point 2) by running a single dispense and

calibrating the difference between its actual and theoretical behavior.

This is a powerful feature, because once the dispenser has been calibrated with advanced
calibration settings, the output data can be transferred to another dispenser with the same
features (same model, same colorants, and same configuration). On the destination dispenser only
a fast calibration will be needed to recalculate the possible difference between the dispense
pumps.

Calibration thresholds

Volumetric dispenses tend to be more precise and easy to repeat if run at slow speed; for this
reason, thresholds can be set so that the speed will vary depending on the dispense quantity
(small dispenses at slow speed and vice versa).

Quantity Speed T olerance Factor
0 1ml g% 10 % 1.29688
. 1 10 ml 30 % hX% 1.06217
. 2 100 ml 80 % 1% 1.02651

Picture 135: thresholds

Depending on the dispenser model, more data may be necessary to set a threshold. The
parameters in Picture 135 are common to all dispensers.

Examples in Picture 135:

. dispenses between 0 and 1 ml use the threshold O parameters.
. dispenses between 1 and 10 ml use the threshold 1 parameters.
. dispenses above 10 ml use the parameters of the last threshold.
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Parameters:

. quantity: quantity required to define a threshold.

. speed: speed required for the dispenses within this threshold.

. Tolerance: tolerance limit to consider calibration data acceptable.

o Notice: this tolerance level is not connected to the dispenser’s precision, but is taken

into account only during the calibration process. A low level corresponds to a slower calibration.
Please remember that slower doesn’t mean more accurate.
. Factor: K Factor referred to the ideal pump. determined automatically during calibration.

Advanced threshold calibration

Every threshold is defined with a maximum and a minimum value. In the first threshold the
minimum value is set through a “Minimum calibration quantity” parameter.

Calibration consists in some quantity tests between the two given values. During each test a
calibration point is saved, which will later be used to make the necessary calculations. A “point of
calibration” expresses the number of steps/quantity dispensed.

First thing, the calibration will run tests on the highest and lowest levels, so as to memorize how
many steps are required to dispense the related quantities.

Depending on the difference between these values and the theoretical values, the K factor is
calculated on the threshold.

If the dispenser's work is linear within the threshold, any other points can be calculated by
interpolation. Obviously, calculating intermediate points between two linear points is useless,
because they are certainly linear as well. Therefore the calibration, when necessary, will run a test
on a quantity placed at one third between the min and max levels. If the output point M is linear
(plus or minus the tolerance), the calibration will be positive, otherwise — with a similar procedure
—the calibration will try to determine the linearity between the min point and the M point, and
between the M point and the max level.

In this way the calibration algorithm will run just a few tests if the product's reaction is linear,
otherwise more points will be added until a correct calibration curve is obtained.

The number of steps necessary for dispensing a quantity will then be calculated by interpolation
between the two closest points.

The advanced calibration performs these operations for all the threshold selected.

If the calibration point is very small, it will be dispensed many times, for a more acceptable result
to be determined; after the tests, the average level is saved.
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Fast calibration

As previously discussed, a K factor is calculated for every threshold. With the fast calibration a
global K factor is calculated, which will edit the factors of every threshold accordingly and
coherently.

The calibration will attempt (with the present calibration data) to dispense a large enough
guantity of colorants. All the factors are updated according to the errors registered during the
dispense.

Example:

. Test quantity: 100 ml.

. Quantity measured after the dispense with the present calibration data: 110 ml.
. the following calculation will be made for all the threshold factors:

New factor = Present factor * 110/ 100.

The global factor is the threshold factor including the quantity dispensed in the fast calibration test

(usually the last threshold).

The fast calibration can be very useful and effective even when there are changes in the specific

weight of the colorants.

121



Appendix B: Connecting TintWise with an external scale

If a dispenser doesn’t have an internal scale, the PC can be connected to one (through a serial
port) so that the automatic calibrations can be made. If the scale can’t be connected, the
calibrations can be made by entering the data manually.

Available scales EI
i i
Gibertini

Add new zcale

Remove scale ‘ Yiew/Modify ‘ Connect ‘ E xit

Picture 136: Connecting to a scale

When a scale appears in the list, click “connect”. TintWise will attempt the connection with the
scale and show an error message in case of failure.

If the operation is successful, open the test window and verify the scale works correctly. Make
sure the displayed weight is correct and try to make a tare. If the operation is successful, the “OK”
button becomes active and the calibration can start.

TintWise shows the ‘Mettler’ and ‘Gibertini’ scales. We recommend checking the parameters to
ensure they are consistent with your scale.

Click the corresponding buttons to add, cancel or edit the scale settings.
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Scale detail Mettler

HName "\'1 ettler

Com number |1 EJ

ious Mext Cancel
Picture 137: Scale settings — general settings
. Name : the scale name.
. Com Number: number of the serial port connected to the scale. Select the right one from

the drop-down menu.
During the connection to the scale, TintWise may ask the user to choose another port if the
selected one is not correct.
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Senal port parameters

B aud rate | 9600

4|

Data bit |,‘a‘ j
Stop bit |1 j
P-Ellit_',' |Even ﬂ

Handzhake | Mane

L4

Previous Cancel

Picture 138: Scale settings — serial port setting

We highly recommend the serial ports settings are exactly the same on both the PC and the scale.
Most commercial scales allow editing these parameters (see the user's manual for your scale).
Remember to set the scale for continuous operations, so that the weight data are sent to the PC
continuously.

NOTICE: some Mettler Toledo scales do not allow setting a “Continuous” mode. In that case the

same goal can be achieved by setting the “Dialog” mode and setting SIR in the initial commands
(see Picture 138).
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Scale detail Mettler £

Scale unit |1_|:||:||:| g

Scale precision |E|.I:I1 Og

[v Autodetect mask

Mask number {505 MNNHHNNN
M for Murmber, = for ather infarmatian

............................................

Previous Mext Cancel

Picture 139: Scale settings — scale data

. Scale unit: the unit of measurement used to view the weight on the scale. Scales are
usually in grams (like in Picture 139).

. Scale precision: sets the scale precision. In Picture 139 the precision is set on one
thousandth of a gram.

. AutoDetect mask: a “mask” is the location where the number (weight) received from the
scale can be found. The software automatically extracts the weight value from the string received.
By enabling AutoDetect mask, TintWise will automatically analyze the information received from
the scale and set the mask. We recommend to keep the autodetect feature active.

. Mask number: the mask settings. If AutoDetect mask is checked, the mask number should
not be modified.
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Scale detail Mettler =

Init commands

W 1 |SIR 4|
[ 5|
[ 6|
Tare
f+ Automatic
Commands
V1T 5|
w2 6|
3| [~
4| 8|
i Yirtual

100,00 g

Tare tolerance |0.100 9

Previous Cancel
Picture 140: Scale settings — commands
. Init commands: the commands sent during the connection to the scale. See the user's

manual of your scale to know if some commands must be given. It is possible to set up to six initial
commands that will be sent in a sequence.

. Tare:

. Automatic commands: if the scale requires specific commands (see the user's manual of
your scale) necessary for the scale to make an automatic tare, select Automatic Tare. It is possible
to set up to six initial commands that will be sent in a sequence.

o) Virtual*: if no specific commands are known, a Virtual Tare can be set. TintWise
will make it automatically, saving the weight measured during that stage. The tare is never made
on the scale.

= Ask for manual tare every: since scales usually lose precision as the weight
increases, this parameter can be set for TintWise to ask for more details: in this case a message
will ask the user to make a tare on the scale with the specific button, if the measured weight is
higher than the given threshold. (In Picture 140 the threshold is set on 100 g).

. Tare tolerance: after a tare is made, TintWise will check that the weight is as close as
possible to zero within a given tolerance, which can be set before starting the dispense.

*NOTICE: most commercial scales are “multirange”, which means the user’s resolution changes
according to the scale’s. If a virtual tare is made, the data may not be accurate enough.
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Appendix C: CTX automatic agitator

If a CTX automatic agitator is available, TintWise can manage an agitation queue consistent with
the dispenses made by the dispenser. The queue will later have to be completed on the CTX by
pressing the buttons on the dispenser.

The agitation is made with a fan rotating inside the canister. During the rotation, a vertical
movement will guarantee that the whole product contained in the canister is agitated the same
way. When the fan is on the bottom of the canister the rotating speed is at its highest, and it slows
down as the fan moves closer to the surface (see the programs setting at CTX Configurator).

At the end of the agitation, the fan must be washed. CTX features an automatic wash tool.

You can set as many agitation programs as you want, and associate the various products/bases of
the formula to a specific program. TintWise will prepare the CTX with the data of the correct
program, depending on the formula to dispense.

Enable the CTX option during the TintWise installation if you want the option to be available. A
series of pop-up messages help the user keep the queue management under control.

i) crx
& new element was added at the queus
Collection 2/Product 3/6225 Lk

Y Tint\Wise

Picture 141: New element

TintWise has added an element to the dispense queue.

i) crx

Collection 1/Product 1/61)25 Lk
is ready to stark

£ TintWwise
Picture 142: Start agitation

The CTX has started an agitation.

i) crx

Collection 1/Product 1781)25 Lk
is kerminated, please wash the shaft

P Tintwise T 'QJ.I ol .

Picture 143: End of agitation

The CTX stops the agitation. Between dispenses, the CTX is set to wash its parts, otherwise the
next agitation and production will not occur. Obviously, if more cans of the same formula are
agitated, the CTX will wash only at the end of the final can.

To ignore the washing and allow the CTX to continue, press the specific button in the CTX Manager
window.
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i ocrx X

YWash terminated

Picture 144: Start wash

A message is displayed at the beginning and the end of every wash.

i) cTx X

CTx Manager will close once agitation queus is kerminated

P-icture 145: Close TintWise

If TintWise gets closed when the agitation has not been yet completed, the CTX manager will keep
working until the process is over.
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CTX Manager

Clicking the CTX icon on one of the messages above opens the CTX Manager window, where all
data of the current agitation can be viewed.

» CTX Manager
Queue
Formula Program Total Dispensed Mixed Ready
> Manual CTX agitalion Prgl 1 1 1] 1
Manual CTX agitation Prg2 1 1 1} 1
Manual CTX agitation Prg3 3 3 1] 3
< Il e
Ignore Wash Add Remove
Status
] Shaft up ] Shaft in agitation position Agitation imer wash timer Current can height
Shaft position Shaft in wash position | 6.5 sec | | 1.5 sec | | 300 mm
| 300 mm | ¥ [iEar sansn: Vibration timer Inactivity timer
[] Shaft down [ Wash required | = | | e | Door Closed
Stand by
Alarms
x Alarm Status Date/Time
(8 ResetCTx

Picture 146: CTX Manager

Above you can see the data of the current agitation. Click the “remove” button to remove an item
from the queue (if the item is not running yet). The running items are highlighted in green color.
TintWise automatically fills the agitation queue, but elements can be added manually by clicking

the “Add” button.

Add queue element

FProgram selection

1. Prgl - Program 1 bt

Cans to mix

| 1 |

4 3

Ok Undo

Picture 147: Add element
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Select the program, the number of canisters to agitate and press “ok”.
The center area of the window shows the sensors’ status and info about the current operations.

On startup TintWise attempts a connection to the CTX; in case of failure an error message is

displayed. Click the connect button on the CTX Manager to attempt the connection at any given
time.

If no association with an agitation program is found after dispensing a formula, the proper
program can be selected manually.

Program selection

Collection 2/Product 3/B2/25 Lt

2. Prg2 - Program 2 bt

[] Learn for next time

4 X

Ok Do not mix

Picture 148: Program selection

Check “Learn for the next time” to save the association settings.
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Alarms

If the CTX generates an alarms, a message will be displayed with the details of the problems, the
current status and data/time info.

See the CTX Manager for the alarms list.

Alarms
Alarm Status Date/Time
‘i‘ Time out horizontal movement On 040672009 11.44.44
Time out vertical movement On 04/06/2009 11.44 44
@ Yoltage 24¥dc not present On 040672009 11.44.44

Picture 149: Alarms

Buttons:
D X: reset the alarms
o V: check the alarms

To remove an alarm from the grid, it must be ckecked first (the corresponding line is green) and
reset it. An alarm should be reset only after the original problem has been solved. Whenever an
alarm is generated, the CTX stops the running operations.

When an alarm is reset but not ckecked, the corresponding line will be highlighted in blue color.
Before removing it from the grid the operator will have to ckeck the alarm.

Alarms
Alarm Status Date/Time
‘& Time out horizontal movement On 0440672009 11.44.44
Time out vertical movement On 0440672009 11.44_44
@ Yoltage 24¥dc not present On 0470672009 11.44.44

Picture 150: Ckecked alarms

Alarms
{ J Alarm Status Date/Time
X Time out horizontal movement off 0440672009 11.45.51
@ Time out vertical movement off 04/06/2008 11.45 51
Yoltage 24¥dc not present OFf 0470672009 11.45.51
Time out horizontal movement On 0470672009 11.45.45
Time out vertical movement On 0440672009 11.45.45
Yoltage 24¥dc not present On 0470672009 11.45.45

Picture 151: Alarms already reset, but not yet ckecked.

Alarms list:

J Inverter horizontal movement failure
. Inverter rotation failure

o Inverter vertical movement failure

. Time out horizontal movement
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. Time out vertical movement

. Voltage 24Vdc not present

. Wash pump failure

See the CTX user’s manual for further information on how to manage the alarms on your
hardware.
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Manual commands

The CTX Manual commands can be accessed from the TintWise main window: Dispenser
management — Manual commands — CTX.

CTX Manual Commands [®]
Shaft Other commands
Rotation
Wash pump
Lights
Alarms
x Yoltage 24V'dc not present
Time out vertical movement
Time out horizontal movement

=

Exit

Picture 152: Manual commands

The CTX parts can be moved manually from this window. It is useful in case of maintenance or
possible problems.
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CTX Configurator

If the CTX is enabled during the TintWise installation the CTX configurator software is installed
with the main program. This software allows editing the dispenser’s settings. We recommend only
expert users have access to the configurator.

&% CTX Configurator
File

Program list | Settings |

Prgl Program Detail |ml
Prg2
Prg 3 Code Description
Prg 4 |Prg1 | |ngram 1 |
Agitation time Low speed Oscillation up
| 60 sec | | 55 % | | 70 % |
Vibration time High speed Oscillation down
| 10 zec | | 60 % | | 0mm |
Wash time

| 20 zec |

& - a S
Add Remove Tave Restore

3

Exit

Exclusions

Picture 153: Program list

On the left side you can see the list of the agitation programs available. Click the corresponding
buttons to add or remove a program.

In the “Exclusion” field you can set the minimum capacity of a canister to be agitated by the CTX.
Dispenses in smaller canisters will not be added to the agitation queue.

On the right side you can view and edit the selected program’s settings and its associations to the
formulation.

134



Program Detail !.Assnciﬂtiuns:
Code Description
Frgl | |Prugrﬂm 1

Agqgitation time Low speed Oscillation up
60 zzc Eh % 0%

Yibration time High speed Oscillation down
10 zec 60 % 0 mm

Wash time

20 sec |

Save Restore
Picture 154: Program detail
. Code: code for the saved data
. Description: program description
. Agitation time: how many seconds the agitation will last.
. Vibration time: how many seconds the vibration will last. “Vibration” is intended as the fan

rotation just above the canister at the end of an agitation, necessary to prevent colorants leftovers
from sticking to the blades.

. Wash Time: how many seconds the washing will last.

. Low speed: minimum speed during the agitation, that is when the shaft is in “oscillation
down” position.

. High speed: maximum speed during the agitation, that is when the shaft is in “oscillation
up” position.

. Oscillation up: expressed in percentage on the can height, automatically detected by the
CTX during the agitation.

. Oscillation down: low agitation position.
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Program DEtﬂi|| Asggociations ]

Association 1 Code
Association 2 |Assuciﬂtiun 1
Selection 1
Collection 1 w
Selection 2
Product 1 w
Base
B1 »

‘ % H o H Load datafrumTintWiseJ
8 S

Save Restore

Picture 155: Associations

Every program can be associated to one or more formulation products.

On the left you can see the list of associations available for the selected programs. Click the
corresponding buttons to add or remove associations.

On the right you can see and edit the selected association details.

. Code: save code

. Selection 1: the formula's first selection level (see Selecting and dispensing a standard
formula).

. Selection 2: the formula's second selection level (see Selecting and dispensing a standard
formula).

J Base: base code.

Clicking the button “Load data from TintWise” the formulation values are added to the drop-down
menu, to make selection easier. The operation may take a while.
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& CTX Configurator [Z“';:'|E|
File

| Program list| Settings '_

Baud rate Shaft up position Wash nozzle up position Oscillation can top offset
(38400 v| ' 500 mm | ' 350 mm | | 20 mm |
Host type Shaft down position Wash nozzle down position Right can detection offset
I [Pc v| f 0mm | | 100 mm | | 250 mm |
Speed min Shaft agitation position
[ I — 1 | [ Wash inactivity enabled Can sensor enabled
_ Speedmax Shaft wash position Wash inactivity time O Vibrator enabled
! 70 % | I] | | 5 min 0 zec |

S

[E

: [
Picture 156: Configuration
. Baud rate: data transmission speed. Do not edit these settings if you’re not an expert
user.
. Host type: set the CTX to work independently or with a PC. Do not edit these settings if
you’re not an expert user.
. Speed min: min fan rotation speed.
. Speed max: max fan rotation speed.
. Shaft up position: shaft up position value. Do not edit these settings if you’re not an
expert user.
. Shaft down position: shaft down position value. Do not edit these settings if you’re not an
expert user.
. Shaft agitation position: shaft agitation position value. Do not edit these settings if you’re
not an expert user.
. Shaft wash position: shaft wash position value. Do not edit these settings if you’re not an
expert user.
. Wash nozzle up position: wash nozzle up position value. Do not edit these settings if
you’re not an expert user.
. Wash nozzle down position: wash nozzle down position value. Do not edit these settings if
you’re not an expert user.
. Wash inactivity enabled: an inactivity control can be enabled. If checked, even if the user

should forget about it, a wash will occur after a given time after the last agitation. This function is
meant to prevent the product on the fan from drying up.

. Wash inactivity time: the time interval from the last agitation before an inactivity wash
starts (if checked).
. Oscillation can top offset: min distance between the fan and the upper part of the can

while oscillating during the agitation.
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. Right can detection offset: it can be used only when data about the height of the cans is
available in TintWise. In that case the CTX will give an alarm if the detected height is different from
the one set.

. Can sensor enabled: enables the can recognition. Do not edit these settings if you’re not
an expert user.
. Vibrator enabled: a vibrating tool is present. If not, the rotation will be provided by the fan

rotating at its highest speed. Do not edit these settings if you're not an expert user.

Buttons:

. Download to PLC: download your settings to the PLC.

Warning: for changes to take effect, the settings must be downloaded to the PLC.
. Upload from PLC: view on-screen the current PLC settings.

. Save: save the PLC settings.

. Restore: restore the last saved data.
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APPENDICE D : login privileges configuration

v Allow login level management v Allow mangement of operators

[~ Automatic shut down v Show desktop

v Show dispenser settings v Allow dispenser settings change v Show manual commands

¥ Show maintenance v Show data v Show options

v Canisters: Allow direct level change [~ Canisters: Allow level alarm change v Canisters: Show Full/Empty buttons

v Cani : Show ad d opti v Canisters: Allow calibration v Cani: - Allow col t/canist iati h

[~ Cani - Allow izt pacity ch [~ Canisters: Allow steps alarm settings change [v Canisters: Allow puige alarm settings change

|v Allow ignore purge alert v Allow manage custom formulas v Show Mew/Edit formula buttons

[~ Allow Logo/Information change [~ Allow customize colorants [ Allow customize cans

[~ Allow advanced settings [~ Allow export data ¥ Show Price button

v Show Print label button v Allow manage dispense queue v Allow create advanced search

v Allow use advanced search [~ Allow standard datab t [~ Allow manage purge advanced settings

KD
Cancel

Picture 157: Login configuration
. Allow logins level management: if enabled at a specific login level, it allows the user logged
in at that level to manage the lower ones.
. Automatic shutdown: check it to shut down the computer automatically on completion of
the running operations
. Show dispenser setting: view the dispenser parameters window.
. Show maintenance: view the maintenance window
. Canisters: allow direct level change. Levels can be changed directly: enter a value in the
text field to change the levels in the canisters, without clicking the filling-up button
. Canisters: show advanced options. Check this one to view the detail menu of the selected
canister.
. Canisters: allow canister capacity change. The physical parameters related to the canister
capacity can be edited.
. Allow ignore purge alert: if checked, the dispensing will proceed even in case of minimum
quantity alert.
. Allow Logo/Information change: see Software options.
. Allow advanced settings: enables the advanced settings.
. Show Print label button: enables label printing and shows the corresponding button in the
main window.
. Allow use advanced search: the color code search is enabled (if the option is available in the
database or it has been created with TintWise).
. Allow management of operators: if enabled at a specific login level, it allows the user
logged in at that level to add, remove and edit the operators associated to the lower levels.
. Show desktop: if it’s not enabled, PC operations outside TintWise will not be possible; we
recommend selecting this option along with “Automatic shutdown”.
. Allow dispenses settings change: settings parameters can be edited.
. Show data: view the voices in the data menu in the main window.
. Canisters: allow level alarm change. Enables changes on the alarm and warning levels. The
alarm level must always be lower than the warning level.
. Canisters: allow calibration. Allows calibrating the dispenser.
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. Canisters: allow steps alarm settings change: change the circuit purge parameters.

. Allow manage custom formulas: allows saving and using the formula stored in the custom
database.

. Allow customize colorants: allows changing or add/remove the components that could be
later associated to a canister.

. Allow export data: Data backup.

. Allow manage dispense queue: allows to manage the dispense queue.

. Allow standard database management: allows to view the Standard database management
window

. Show manual commands: allows accessing the manual commands window.

. Show options: view the options page.

. Canisters: show the fill/empty buttons.

. Canisters: allow colorant/canister association change

. Canisters: allow purge alarm setting change

. Show New/Edit formula buttons: enable the corresponding buttons in the main window.

. Allow customize cans: allows accessing the can customization window.

. Show price buttons: enable the corresponding button in the main window.

. Allow create advanced search: enable the advanced search tool directly from TintWise.

. Allow manage purge advanced settings.
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Revision History

Here the list of the main modifications of TintWise on its releases.

5.2.0.0

e Multiple discount management

* Possibility to customize printer settings

* Suck back speed for Archimede/Eureka

* Unblock cycles set in step for Archimede/Eureka

* Refill option after calibration

e Full/Empty buttons on fill up page

* Possibility to customize text and background colours in formula’s detail
e Base quantity view

e Automatic updates through internet

* Improved license management

5.1.0.16

* Formula percentage management
e Combined dispense on Archimede/Eureka
* Possibility to choose the grid selection mode (single or double click)

5.1.0.15

e Standard formula selection mode management

e Sequential electronic board firmware 1.8

* Simultaneous electronic board firmware 1.2

* Possibility to select the can size from the price page.

5.1.0.14

* Formula color view management
e Formula notes management

5.1.0.13

e Automatic firmware update for Archimede/Eureka

e Sequential electronic board firmware 1.7

* Simultaneous electronic board firmware 1.1

e Possibility to customize the order for the selection of the cans

5.1.0.12

¢ Maintenance management.
e Exportation quick selection.
e Possibility to have a double price management.

5.1.0.11

e Customers management.
e Reports management.
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e More fractions unit of measurement management.
e Automatic label printing.
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